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Chapter 1 – General Information 

This manual describes the hardware (the FloBoss™ 107-based 
Distributed RTU™ CPU and the Network Radio module, or “NRM”), 
the software (the defined nodes and the network access point) 
components of Remote Automation Solutions’ Distributed RTU™ 
Network, and the software tool – the ROCLINK 800 component of 
OpenEnterprise™ Field Tools – you use to configure the components 
into a network and to define the flow of data in and out of the network.   
This chapter details the structure of this manual and provides an 
overview of the pieces of the Distributed RTU Network (“DRN”) 
solution.  

In This Chapter 

1.1 Overview ................................................................................................ 1-1 
1.1.1 DRN Components ..................................................................... 1-2 

1.1 Scope of Manual .................................................................................... 1-3 
1.2 Hardware ............................................................................................... 1-3 

1.2.1 CPU Module.............................................................................. 1-4 
1.2.2 Network Radio Module (NRM) .................................................. 1-4 
1.2.3 Nodes ........................................................................................ 1-5 
1.2.4 Network Access Point (NAP) .................................................... 1-6 
1.2.5 Firmware/Software Versions..................................................... 1-6 

1.3 System Security ..................................................................................... 1-7 
1.3.1 Radio Encryption ...................................................................... 1-7 
1.3.2 Migrating to an Encrypted Network .......................................... 1-7 

1.4 SCADA Systems and the Distributed Network ...................................... 1-8 
1.5 Configuration/Commissioning Software ................................................ 1-9 
1.5.1 System Diagnostics ............................................................................... 1-9 
1.6 Additional Technical Information.......................................................... 1-11 
 

 

1.1 Overview 
Production pads with multiple wells (typically used in shale gas or oil 
production) present special challenges to gathering and controlling 
process variables. Often the wells are distributed over a wide geographic 
area, making wired connectivity difficult and control and remote point 
monitoring problematic.   
Remote Automation Solutions’ Distributed RTU Network (DRN) 
solution provides a unique and cost-effective resolution to this 
challenge. The DRN structures data acquisition and transmission in a 
true peer-to-peer network (rather than a more traditional master-slave 
arrangement), uses wireless technology to improve data transmission, 
and enables you to design – and quickly re-design – both the network 
structure and the flow of data through the network.  
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1.1.1 DRN Components  
A DRN has two primary pieces: at least one node and a network access 
point (NAP). The node collects information from wired or wireless 
HART devices or standard I/O points located at critical locations on the 
production pad and wirelessly transmits that information into the 
network. The network access point enables you to open a software 
“window” into the data network and extract, configure, manipulate, or 
otherwise manage the transmitted data as necessary using ROCLINK 
800. 

Node 
 

A node is typically a four-slot FB107 chassis with a focused-
functionality CPU and an installed Network Radio module (NRM). By 
removing support for several standard FB107 functions, the CPU can 
manage the input and output traffic from up to 32 wired or 
WirelessHART® devices per minute. To acquire these signals, you 
install a HART® module (for wired devices) and/or an IEC 62591 
Wireless Interface module wired to a Smart Wireless Field Link (for 
wireless devices). 

Each node supports one NRM, which wirelessly transmits data to and 
receives data from up to either 11 or 23 other nodes, depending on the 
system configuration model (12-node or 24-node) you select.  

Note: Although a HART module can support up to 20 HART devices 
and an IEC 62591 module (wired to a Smart Wireless Field 
Link) can support up to 20 WirelessHART devices, that 
cumulative load exceeds the 32-device functional limit of the 
DRN node. Each node is designed to transmit a maximum of 30 
export values (or “events”) per second and to receive a 
maximum of 128 import values per second.  

Network Access 
Point (NAP) 

Each DRN has one network access point (NAP), through which you 
initially configure and subsequently modify the nodes and the network 
of nodal data relationships. Typically, you install an NRM into a fully 
functioning FB107, ROC800, or ROC800L to create a network access 
point. You can then use ROCLINK 800 to access the FB107 or ROC800 
and view, manage, or collect the information provided by the nodes on 
the DRN. 

Figure 1-1 shows a simple DRN with one node (with an installed IEC 
62591 module) and one network access point (a ROC800 with an 
NRM).  
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A WirelessHART field devices (in mesh field network) 
B Smart Wireless Field Link (wired to IEC 62591 module) 
C Node with CPU, NRM, and IEC 62591 Wireless Interface module 
D Network Access Point (ROC800 with NRM) 

Figure 1-1. Simple DRN with Single Node and Network Access Point  

1.1 Scope of Manual 
This manual contains the following chapters:  

Chapter 1 
General Information 

Provides an overview of the hardware and software 
for the Distributed RTU Network solution. 

Chapter 2 
Installation 

Provides information on installing the physical 
network of nodes. 

Chapter 3 
Commissioning and 
Designing 

Provides information on using Field Tools software to 
commission the network nodes and design the data 
network.   

Chapter 4 
Troubleshooting 

Provides techniques and procedures on diagnosing 
and correcting problems for the Distributed RTU 
Network.  

Appendix A: 
Glossary 

Provides a general listing of acronyms and terms. 

Appendix B: 
Optimizing Wireless 
Communications 

Provides general information on wireless networks 
and how to structure and place components for 
maximum results. 

Index Provides an alphabetic listing of items and topics 
contained in this manual.  

1.2 Hardware 
Each node has two basic components: the Distributed RTU™ CPU 
(CPU) module and a Network Radio module (NRM).  

Note: Although nodes are most often a focused-functionality FB107 
with a DRN CPU and an NRM, you can also install a NRM in a 
ROC800 or a full-function FB107 and define that device as a 
node. Refer to Section 1.2.3 for more information.  

B 

A 

D 

C 
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1.2.1 CPU Module  
The firmware in the CPU module designed for use in the DRN has been 
modified to specifically manage the input and output from the 
peripheral HART devices associated with the node. To accomplish this 
requirement and to support HART Pass-Through, the following 
functionality has been disabled:  
 Support for meter runs 
 Support for standard history 
 Support for DS800  
 Support for the expanded backplane.   
However, the following critical functionality has been retained:  
 Support for I/O scanning for all types of I/O modules (including the 

HART and IEC62591 Wireless module)  
 Support for User C application programs  
 Support for one PID loop 
 Support for one FST  
 Support for expanded history 
 Support for alarm and event logging  
 Support for the FB107 LCD local display  
 Support for user lists  
You power the CPU (and the node) using a standard 8-30 Vdc power 
source. For further information on wiring the CPU, refer to Chapter 3 of 
the FloBoss™ 107 Flow Manager Instruction Manual (Part 
D301232X012).   

1.2.2 Network Radio Module (NRM) 
The Network Radio module is designed to be plug-and-play and 
requires no wiring. Depending on the enclosure you choose to surround 
the node and protect it from the environment, you may need additional 
cabling between the antenna and the connection on the module itself.  
Installing a NRM in the node provides the wireless connectivity among 
nodes and the NAP in the network. See Figure 1-2; the ROC800-
specific NRM is on the left and the FB107-specific module is on the 
right.  

Module Placement The NRM is a communications module. In a ROC800-Series, you can 
only install it in slots 1, 2, or 3 (the slots immediately to the right of the 
CPU). In an FB107, you can install the NRM in either slot 1 or 2 (the 
slots immediately to the right of the CPU) of the base unit. You cannot 
install the NRM in any slot on an FB107 expansion unit. Both the 
ROC800 and FB107 support only one NRM. 
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Figure 1-2. Network Radio Modules (for ROC800 and FB107)  

Note: Only a ROC800 using a Series 2 CPU supports the NRM.   

LEDs The five LEDs on the NRM’s faceplate provide useful diagnostic 
information.  

Table 1-1. Module LEDs  

LED 
Label 

If Installed in 
NAP 

If Installed in  
Node 

LINK Always on On (non-blinking)=joined network and 
commissioned 
Blinking=joined to network but not 
commissioned 
Off=Not joined to network   

NAP Always on Always off 
SSI Always on On (non-blinking)=good signal-to-noise ratio 

(signal is strong) 
Blinking=adequate signal-to-noise ratio (signal 
is adequate) 
Off=poor signal-to-noise ratio (signal is weak) 

TX Blinking=TX 
activity on 
radio 

Blinking=TX activity on radio 

RX Blinking=RX 
activity on 
radio  

Blinking=RX activity on radio  

1.2.3 Nodes  
A node is usually a four-slot FB107 chassis with a focused-functionality 
CPU and an installed Network Radio module (NRM). The remaining 
two empty slots on the FB107 chassis support any other FB107 I/O 
module. For example, if you have a number of WirelessHART devices 
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to support, you may choose to install an IEC 62591 Wireless Interface 
module (wired to a Smart Wireless Field Link). For wired HART 
devices, you can install a HART module, or you may just choose to 
install two I/O modules for additional I/O capability.   

Node 
Characteristics 

Each node can process and transmit a maximum of 30 data variables 
each second. Once connected, nodes communicate in a true peer-to-peer 
network, rather than a poll-response relationship.  
Any node can receive up to 128 variables per second from a 
transmitting node; you determine the flow of data in the network. Since 
the DRN supports either a 12-node or 24-node configuration, the 
network can be as simple or as complex as your data needs require. 
Finally, when you add a node to the network (using the Network Access 
Point), the network automatically recognizes the node. 

Note: Although nodes are most often a focused-functionality FB107, 
you can also install a NRM in a ROC800 or a full-function 
FB107 and define that device as a node. Refer to Chapter 2 for 
more information.  

1.2.4 Network Access Point (NAP) 
Each DRN has only one network access point through which you 
initially configure and subsequently modify the nodes and nodal data 
relationships network. Typically the network access point is a ROC800, 
ROC800L, or full-featured FB107 with an installed Network Radio 
module. Using Field Tools software, you connect through the network 
access point and configure and define the network.  NAPs can receive 
up to 128 variables per second and transmit up to 30 variables per 
second.  

Module Placement The NRM is a communications module. In the ROC800-Series, you can 
only install it in slots 1, 2, or 3 (the slots immediately to the right of the 
CPU). In the FB107, you can install the NRM in either slot 1 or 2 (the 
slots immediately to the right of the CPU) of the base unit. You cannot 
install the NRM in any slot on an FB107 expansion unit.  

1.2.5 Firmware/Software Versions  
Table 1-2 shows the software and firmware versions required to support 
the DRN:  

Table 1-2. Firmware/Software Versions  

Product Firmware/Software Version 
FloBoss 107 1.70  
Distributed RTU CPU 1.70  
Network Radio Module (NRM)  1.10  
ROCLINK 800 2.50  
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Product Firmware/Software Version 
ROC800-Series 3.70  
ROC800L 1.50  
Enhanced Communications Module (ECM) 1.01  

 

Note: If you use a FB107 with an installed ECM as a network access 
point, you must upgrade the ECM module to firmware version 
1.01. This upgrade increases the wait time in the ECM to 
specifically accommodate the longer response times for the 
nodes.   

1.3 System Security  

Security in control systems is a critical concern. Using the security 
features within ROCLINK 800, you can provide a SCADA 
(Supervisory Control and Data Acquisition) system with access to all 
nodes in the network by defining permissions for a specific comm port. 
Using those same features, you can restrict technician access to specific 
nodes (control points). Refer to Chapter 2, Installation, for specific 
instructions.   

1.3.1 Radio Encryption  
Encrypting the radio signal from the NRM maximizes data security. 
Remote Automation Solutions offers a 256-bit encrypted version of the 
NRM for situations where security may be a concern. However, you 
cannot mix encrypted and non-encrypted NRMs in the same network. 
All NRMs in a network must be either encrypted or non-encrypted. 
Consult with your LBP for further information.  

1.3.2 Migrating to an Encrypted Network  

Note: To ensure your network performs correctly, it is considered a 
“best practice” to review and rebalance your network’s radio 
transmit power settings any time you replace an NRM module. 
This includes when you are upgrading to encrypted radio 
modules. .   

The encrypted Network Radio modules are designed as plug-and-play 
replacements for non-encrypted NRMs. To migrate to an encrypted 
network, you:  
1. Power down the individual node.  
2. Replace the non-encrypted module with an encrypted module.  
3. Power up the node.  
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4. Connect to the node using ROCLINK 800. 
5. Access the NRM module and open the Encryption tab. 
6. Enter the pre-defined encryption key for your network.  
7. Click Apply to save your changes.  
8. Close ROCLINK.  
Repeat this process for each node in the network. Once you have 
installed and configured encrypted modules in all nodes, perform this 
process with the network access point. Once you click Apply after 
installing the encrypted module in the NAP, the system automatically 
refreshes all data imports and exports defined for your network.   

1.4 SCADA Systems and the Distributed Network  

The presence of a SCADA system installed in conjunction with the 
Distributed RTU Network requires special considerations.   

Conflicts in data traffic can occur if the Network Access Point (NAP) 
and one or more nodes are also equipped with SCADA radios (also 
known as “long-haul” radios, which have more power and operate at 
lower frequencies than the radios installed on the Network Radio 
modules). If the SCADA system tries to acquire information at the same 
time as the DRN system, data traffic conflicts can occur as signals 
attempt to pass through the same devices at the same time.   

To manage this situation, you can disable the SCADA data pass-through 
activity in select DRN nodes. This prevents the NAP from passing 
SCADA requests it receives to nodes in its network. (The individual 
nodes can still respond to requests directly from the SCADA system.) 
Refer to Chapter 3, Commissioning and Designing, for specific 
instructions on disabling or enabling SCADA activity on nodes 
equipped with long-haul radios.  

Note: Which DRN nodes you disable is a function of the overall design 
of your network, in association with the data requirements of 
your SCADA system.   

ROCLINK 800 
Access 

Another possible conflict with SCADA data pass-through may occur 
when you connect ROCLINK 800 to the Network Access Point. For this 
reason, the DRN software automatically disables SCADA pass-through 
on the port (LOI or Ethernet) while you are connected. The DRN 
software automatically restores pass-through between the NAP and the 
nodes when you close the ROCLINK 800 session.  

Note: If the individual nodes have long-haul SCADA radios, the nodes 
can continue to receive and respond to SCADA requests while 
ROCLINK 800 is connected to the NAP. Only the pass-through 
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between NAP and nodes is suspended when ROCLINK 800 is 
connected.   

Refer to Appendix C, Using OE Field Tools to Access the DRN, for 
further information on accessing a DRN using OpenEnterprise™.  

 
 
 

1.5 Configuration/Commissioning Software 
OpenEnterprise™  

Field Tools 
OE Field Tools is a comprehensive software solution that folds a number 
of Remote Automation Solutions configuration software tools–such as 
ROCLINK 800, ControlWave Designer, and TechView–into a single 
point-of-access tool. Field Tools simplifies the process of defining and 
maintaining the DRN.  

Once you have installed the individual nodes, you use ROCLINK 800 to 
interconnect the nodes. Refer to Chapter 3, Configuring and 
Commissioning, for specific instructions.  

1.5.1 System Diagnostics  
The ability to monitor the processing “health” of any component of the 
Distributed RTU Network is a critical diagnostic tool.   
Once you open a ROCLINK 800 session, select a node’s Advanced tab 
to display essential operating components: noise level, signal strength, 
the percentage of good packets received, and the current network status:  

 

Figure 1-3. Node Diagnostics  

Accessing this same information through the Network Access Point 
opens a single-screen summary of these values for each node in either a 
12- or 24-node network:   
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Figure 1-4. Diagnostics from the Network Access Point  

Using this screen, you can scan the general system health and identify 
individual nodes which may be problematic. For further information on 
the diagnostic options this screen provides, refer to Chapter 3.   
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1.6 Additional Technical Information  
Refer to the following documents for additional technical information:. 
The most current versions of these technical publications are available 
at www.EmersonProcess.com/Remote. 

Table 1-3. Additional Technical Information  

Name Form Number Part Number 
FloBoss™ 107 Distributed RTU Network Bundle FB107:DRN D301730X012 
ROC800-Series Network Radio Module ROC800:NRM D301732X012 
FloBoss™ 107 Network Radio Module  FB107:NRM D301731X012 
FloBoss™ 107 Flow Manager Instruction Manual  A6206 D301232X012 
ROC800-Series Remote Operations Controller Instruction 
Manual 

A6175 D301217X012 

ROC800-Series IEC 62591 Wireless Interface Module ROC800:62591 D301689X012 
FloBoss™ 107 IEC 62591 Wireless Interface Module FB107:62591 D301713X012 
IEC 62591 Wireless Interface Instruction Manual  A6321 D301708X012 
OpenEnterprise™ Field Tools Configuration Software OE:FT D301735X012 
FloBoss™ 107 HART® Module FB107:HART D301639X012 
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Chapter 2 – Installation 

This chapter provides guidelines on designing your RTU network and 
describes how to configure and then install the nodes of the Distributed 
RTU Network.  

Note: Because the structure of any particular DRN is tailored to your 
specific geographic site, we can only present an idealized model 
of a DRN and use it to explain the processes of installing, 
configuring, and commissioning. Consult with your Remote 
Automation Solutions representative to determine the optimal 
configuration for your particular site.    

In This Chapter 

2.1 Planning the Network ............................................................................. 2-1 
2.1.1 Mapping the Network ................................................................. 2-1 
2.1.2 Example: 21-Node Network ....................................................... 2-2 
2.1.3 Example: Multi-well Pad with One Node per Eight Wells ........... 2-3 
2.1.4 System Security ......................................................................... 2-3 

2.2 Configuring Nodes ................................................................................. 2-5 
2.2.1 Configuring a ROC800 or FB107 as a Node .............................. 2-8 

2.3 Field Installation ..................................................................................... 2-8 
2.3.1 Grounding Considerations .......................................................... 2-8 

2.4 Calculating Power Requirements ........................................................ 2-10 
2.5 Using an Enclosure .............................................................................. 2-12 

 

 

2.1 Planning the Network  
You can install the DRN either with a maximum of 12 nodes or with a 
maximum of 24 nodes. Which version you install is based on how you 
anticipate data should flow through the network.  

2.1.1 Mapping the Network  
By mapping out your network before you install any nodes, you can 
anticipate and resolve potential issues (such as locations which might 
need an antenna mast, placement of solar panels, and so on) as well as 
streamline the actual installation process. As Figures 2-1 and 2-2 show, 
the DRN is flexible enough to accommodate a variety of physical 
configurations. Additionally, you can add and field-configure nodes 
(within the limitations for your chosen DRN size) as your data needs 
change, as well as change how data flows through the network.   

Note: For further information on power requirements, refer to the 
product data sheets FB107:DRN, FB107:NRM, or 
ROC800:NRM. For further information on how to optimally 
locate nodes for maximum communication, refer to Appendix B, 
Optimizing Wireless Communications.  
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Review Figure 2-1 and Figure 2-2. Both show the same physical 
wellpad structure configured in two different ways.  

2.1.2 Example: 21-Node Network  
Figure 2-1 shows a 16-well pad with one node per well. Each separator 
(with its own meter run and flow value) is wired to its own flow 
computer (a ROC800 or FB107). Each flow computer has an installed 
Network Radio module (NRM). An additional node provides data from 
the storage tanks. Using 21 nodes, this network also shows the network 
access point (NAP), peer-to-peer, many-to-one, and one-to-many data 
relationships (which you define when you configure the network).   
1. Network access point (NAP): Field Tools permits access and storage 

of configuration data from all the DRN nodes.  
2. Many-to-one data flow: a single node can receive data from multiple 

nodes in the network at each update period. Information from the 
individual production wells flows to the RTU.  

3.  Peer-to-peer network: any node can receive or send data to any 
other node in the network without passing through the Network 
Access Point. Information flows between RTUs.  

4. One-to-many data flow: one node within the network can send data 
to multiple other nodes each update period. Information from the 
storage tanks flows to each RTU.  

 
1 Network access point (NAP) 
2 Many-to-one data flow 
3 Peer-to-peer network 
4 One-to-many data flow 

Figure 2-1. 21-Node Network: Multi-well Pad with One Node per Well 
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2.1.3 Example: Multi-well Pad with One Node per Eight Wells  
Figure 2-2 shows the same physical well pad as in Figure 2-1 but 
structured as a 7-node network. In this case a node acquires data from 
eight wells (grouped as a pit). Each node then communicates with two 
RTUs.  

 
1 Network access point (NAP) 
2 Many-to-one data flow 
3 Peer-to-peer network 
4 One-to-many data flow 

Figure 2-2. 7-Node Network: Multi-well Pad with One Node per Eight Wells 

2.1.4 System Security  
You want a SCADA system to transparently access all the nodes in your 
network. Alternately, you may want to restrict access if technicians need 
to service individual nodes. The Distributed RTU Network can provide 
both the transparency and the restrictions you require, and you can 
change these settings as your requirements change. Figure 2-3 presents 
a simple usage scenario.  
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Figure 2-3. DRN Security 

In this scenario, the SCADA system uses the Comm2 port, for which 
security has been disabled. Any messages from Comm2 pass 
immediately to the nodes and vice versa.  
On the other hand, a technician connects to the NAP using the LOI, for 
which User ID level-security has been enabled. Similar, each node also 
has User ID level-security enabled. For Node A, the correct User 
ID/password is JOE/1234. For Node B, the correct User ID/password is 
DAV/5678.   
This arrangement permits technician JOE (using the “Connect to 
Device” option) to log onto Node A with secure over-the-air access. If 
JOE tries to access Node B using JOE/1234, Node B rejects the attempt. 
Only technician DAV using password 5678 can successfully access 
Node B.  

Note: Remember that the position of the NRM dictates the comm port 
used. Placing the NRM in slot 1 of the FB107 activates Comm3; 
placing the NRM in slot 2 activates Comm2. This example 
assumes the NRM is placed in slot 1 of the nodes.   
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Defining 
Access 

You define these communication port-based security settings using the 
Device Security screen in ROCLINK 800.   
Select ROC > Security on the ROCLINK toolbar to display the Device 
Security screen:  

 
Figure 2-4. Device Security (FB107) 

Select the User ID Enabled option for the appropriate communication s 
port, define the technician’s ID and password, and click Apply.   

2.2 Configuring Nodes  
Once you have determined the size of your DRN, assemble your nodes. 
You need to configure each node individually with four pieces of 
network-specific information: Network ID, Channel, Radio Transmit 
Power, and whether the node is a network access point.   

Note: Although you can field-configure nodes, it may be easier to 
perform the configuration on a bench or other protected location.   

To configure a node, you need a PC running ROCLINK 800 (Version 
2.50 or higher). Connect to the node using the LOI port and start 
ROCLINK. Once ROCLINK starts, click on the Network Radio module 
to display the NRM configuration screens. Select the Network tab to 
display the network configuration values:  
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Figure 2-5. Node Configuration Screen 

Complete the following fields:  

Field  Description 
Network ID Enter a valid Network ID (between 0 and 255). The 

network ID identifies all the devices (nodes and 
network access point) belonging to that network, so 
all devices on a network must have the same 
network ID.  
Note: Additionally, each network you define 

must have a unique ID.  
Channel Enter a valid channel (between 0 and 14). As with 

the network ID, all devices belonging to the same 
network must have the same channel.   

Encryption Type This display-only field shows the encryption type 
of the on-board radio. Valid values are none or 256 
bit.  

Radio Transmit Power Indicates, in decibels of measured power, the 
relative strength of the radio signal for this node. 
Although all nodes in a network typically have the 
same value for this field, you can adjust this value 
to “boost” the signal for nodes in more remote or 
less-than-optimal situations.  
The system calculates the draw in mW and 
completes this field based on the value you enter.  
Note: The higher the value in this field, the more 

power the node draws from its battery when 
it transmits data.  

Stale Data Timeout Indicates, in seconds, how long the system waits 
for data to refresh before noting it as “stale.” 

Network Access Point Leave this check box blank for nodes.  
Configure Click to apply the indicated values to the node.  
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Duplicating Node 
Configurations 

If you have a number of nodes in the same network to configure, you 
can define one node, copy the .800 configuration file from that node, and 
then install that file into other nodes.   

To mass-configure nodes:  
1. Connect to the node containing the configuration you want to copy.  
2. Select File > Save Configuration from the ROCLINK menu.  
3. Save the .800 file. (Use a filename such as “Node_Config” to 

uniquely identify the .800 file.)   
4. Attach to the LOI port on the next node.  
5. Select File > Download and select the name of the .800 file from 

step 2. 
6. Click Open. ROCLINK copies the indicated configuration file into 

the new node.    
7. Repeat until all nodes are configured.  

Device Group and 
Address 

You must configure all devices in a Distributed RTU Network to use the 
same network ID and the same channel. Configure all devices in 
adjacent networks with a different network ID and a different channel. 
Additionally, to enable a SCADA system to poll all of the devices on the 
network, all devices on the network must belong to the same group, and 
each device in a network must have its own unique address. (Essentially, 
the group number identifies the network “family,” while the address is 
the individual device’s “given” name.)    

Station Name The station name is a unique name for the selected device. The station 
name (sometimes referred to as the “device tag”) appears in many places 
on the RTU Network screens. It is a good practice to assign a unique 
name for each device to help differentiate the devices on your network.     
To check the group, address, and station name for a device, select ROC 
> Information from the ROCLINK 800 menu bar. The Device 
Information screen displays.   

 

 

Figure 2-6. Device Information Screen (ROC800 and FB107) 
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2.2.1 Configuring a ROC800 or FB107 as a Node  
If required for your organization’s data needs, you can install a Network 
Radio module in a ROC800 or FB107 already in the field and define 
that ROC800 or FB107 as a node in a network.  

Note: You must install the NRM in a communications slot on the 
ROC800 (slot 1, 2, or 3) or FB107 (slot 1 or 2). 

Connect a laptop to the LOI port on the ROC800 or FB107 and start 
ROCLINK 800. Click on the image of the NRM to begin the 
configuration process. As shown in Figure 2-5, use the Network tab for 
a FB107. For a ROC800, the configuration information appears on the 
Module/Network tab.   
Provide the same information (Network ID, channel, and Radio 
Transmit Power) as for any other node on the same network. Click 
Apply to save the network configuration values to the NRM.  

2.3 Field Installation  
Once you have configured all nodes, you can perform the field 
installation. Refer to the site map you have prepared indicating the 
location of all nodes, as well as power requirements (DC, battery, or 
solar panels).  
Bench-configure the individual nodes with ROCLINK 800, identifying 
the Network ID, Channel, Radio Transmit Power, and yes/no to 
Network Access Point. Attach to the LOI port on node, start ROCLINK 
800, and access the Module/Network tab.  

2.3.1 Grounding Considerations  
Grounding any electronic device is essential to successful operation. 
Ensure that the field installation of your Distributed RTU Network 
components addresses and manages any potential electrical discharges 
(as shown in Figure 2-7).  



Distributed RTU Network Instruction Manual 

Revised December-2015 Installation 2-9 

 
A Antenna mast assembly (to situate antenna at least 20 feet up from the ground)  
B Surge protection device 
C Customer-provided weatherproof enclosure for Distributed RTU Network 
D Grounding bar  
E Heavy-gauge solid wire  
F Earth grounding method  

Figure 2-7. A Grounding System 

 

 Caution Ensure a secure, low-impedance electrical connection between the 
surge protector, the housing, the grounding bar, and the earth 
grounding method.   

 

For further information on grounding guidelines, refer to:  

• Standards and Guidelines for Communications Sites, Motorola 
Publication 68F81089E50-B, Motorola, Inc., 1995  

Note: This publication is also known as the “R56 manual.” 

• Lightning Protection & Grounding Solutions for Communications 
Sites, Ken R. Rand, Polyphaser®, 2000 
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2.4 Calculating Power Requirements  
Because you place the Distributed RTU Network in an isolated 
environment, device autonomy – how long a device can function solely 
on either battery or solar power – is an essential operational concern.  
 

 Caution Temperature and other environmental conditions can affect how a 
battery or solar panel functions. Adjust any autonomy requirements 
and calculations based on site conditions.  

 

Table 2-1 assumes a typical FloBoss 107 Distributed RTU Network 
bundle: a four-slot FB107 chassis loaded with a Distributed RTU 
Network CPU (non-isolated with on-board I/O) and a Network Radio 
module.  

Table 2-1. Module Power Information 

 
 

Slot 

 
 

Module Description 

 
Base Idle 
(No Load) 

 
Max Active  
(Full Load) 

 
Loading  
Factor 

 
Module Power 

in mW 
0 CPU Non-isolated with I/O  396 mW 476 mW 100% 476 
1a Network Radio Module 

(non-encrypted) 
288 mW 720 mW 100% 720 

1b Network Radio Module 
(encrypted) 

398 mW 1152 mW  1152 

2 empty -- -- --  
3 empty -- -- --  

Totals (with non-encrypted 
module) 

684 mW 1196 mW 100% 1196 

Totals (with encrypted module) 794 mW  1628 mW 100% 1628 

Note: If you choose to install additional modules (such as a 6-point I/O 
module), refer to Determining Power Consumption in Chapter 3 
of the FloBoss 107 Flow Manager Instruction Manual (part 
D301232X012) for additional power requirements. 

Table 2-2 is the worksheet used to determine power requirements:  
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Table 2-2. Blank Power Consumption Worksheet 

Power   
Field Power (mW) ----   

Total Power ---- 
Voltage   

Input Voltage (V dc) ----   
Current   

System Current mA ----   
Communications mA (Average) ----   

Total Current mA on Power System ----  
Miscellaneous   

Battery Voltage ----   
Battery Capacity Amp/Hour ----   

Depth of Discharge ----   
Available Hours ----   

Days of Autonomy ----   
 

A Field Power is sum of the active load values for all modules  
B Total Power is the maximum active load of all modules at all times.  
C Voltage indicates the input voltage of the power source (in this case, typically a 12 Vdc 

battery)  
D Total Current mA on Power System represents the Total Power value (B) divided by 

the Voltage value (C), expressed as mA. 
Note: When applicable, this value would also take into consideration any external current 
through communications devices.  

E Miscellaneous represents several components: 
 Battery Voltage A given value from the battery manufacturer  
 Battery Capacity A given value in Amp/Hr from the battery manufacturer  
 Depth of Discharge Maximum percentage of discharge for the battery  
 Available Hours Number of hours the unit can be powered without external 

charging of the power system. This value is the battery capacity (in 
Amp/Hrs) divided by the Total Current mA on Power System 
value.   

 Days of Autonomy Available hours divided by 24.  
 
Using the values presented in Table 2-1, the completed Power 
Consumption worksheet looks like Table 2-3.   

Note: Table 2-3 assumes a typical FloBoss 107 Distributed RTU 
Network bundle: a four-slot FB107 chassis loaded with a 
Distributed RTU Network CPU (non-isolated with on-board I/O) 
and a Network Radio module. 

B 
C 

D 
E 

A 
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Table 2-3. Completed Power Consumption Worksheet 

Power   
Field Power (mW) 1196   

Total Power 1196 
Voltage   

Input Voltage (V dc) 12   
Current   

System Current mA 99.7   
Communications mA (Average) 0   

Total Current mA on Power System 99.7 
Miscellaneous   

Battery Voltage 12 v   
Battery Capacity Amp/Hour 7 x .80 = 5.6   

Depth of Discharge 80%   
Available Hours 56.17   

Days of Autonomy 2.34   
 

A 476 mW + 720 mW = 1196 mW 
B 1196 mV 
C 12 V 
D 1196 / 12 = 99.666667 
E  7 Amp/Hr x .80 (depth of discharge) = 5.6 Am/Hr =  
 80% (100% - 20% reserve) 
 (5.6  / 99.7) x 1000 (conversion from mW to W) = 56.17 
 56.17 / 24 = 2.34 days of autonomy 

 
Based on this example, we can expect the Distributed RTU to operate 
for a little more than two days without supplemental power. Use the 
worksheet to proactively anticipate and meet your power needs and 
keep your system operational. 

2.5 Using an Enclosure  
If you install the Distributed RTU in an enclosure, make sure that you 
provide sufficient space between the antenna connections on the 
Network Radio Module and the inside of the enclosure door. If the door 
impacts the antenna cables or connections, it can damage the module 
and affect your network’s successful operation.   
 

 Caution Provide enough space between the back of the enclosure door and the 
module’s antenna connections and cabling. If necessary, use a right-
angle SMA jack to ensure clearance.   

 

B 

C 

D 

E 

A 
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Chapter 3 – Commissioning and Designing  

Once you have determined the physical structure of your network and 
installed the nodes and the Network Access Point (NAP) for your 
Distributed RTU™ Network (DRN), you can begin the process of 
adding the network components and determining how data flows 
through the network. Keep in mind that this network is entirely 
responsive to your needs: as your requirements change, you can easily 
change the flow of data between individual nodes and the NAP.  

Note: The examples in this section are intended only as illustrations, 
and come from several different Distributed RTU Networks. The 
examples are not intended and should not be interpreted to 
represent the operation of one Distributed RTU Network.   

 
In This Chapter 

3.1 Displaying Module Information ........................................................ 3-2 
3.1.1 Module Information: FB107 .................................................. 3-2 
3.1.2 Module Information: ROC800............................................... 3-8 

3.2 Commissioning .............................................................................. 3-12 
3.2.1 Discovering Nodes ............................................................. 3-13 
3.2.2 Commissioning Nodes ....................................................... 3-14 
3.2.3 Color Coding (Commissioned Table) ................................. 3-19 
3.2.4 De-commissioning Nodes .................................................. 3-20 
3.2.5 Re-commissioning Nodes .................................................. 3-21 
3.2.6 Duplicating Node Configurations ........................................ 3-22 

3.3 Designing Data Networks .............................................................. 3-23 
3.3.1 Adding Imports and Exports ............................................... 3-26 
3.3.2 Configuring Data Imports ................................................... 3-33 
3.3.3 Duplicating Imports and Exports ........................................ 3-34 
3.3.4 Deleting Imports and Exports ............................................. 3-36 
3.3.5 Color Coding (Design Workspace) ..................................... 3-38 
3.3.6 Pop-up Menus .................................................................... 3-39 
3.3.7 Saving a Network Configuration ......................................... 3-43 
3.3.8 Downloading a Network Configuration ............................... 3-44 
3.3.9 Creating a Network Configuration Template (Offline) ........ 3-46 
3.3.10 Downloading a Network Configuration Template ............... 3-50 
3.3.11 Copying a Network Configuration (Online) ......................... 3-57 
3.3.12 Restoring a Single Device Configuration ........................... 3-62 
3.3.13 Restoring an Entire Network Configuration ........................ 3-64 

3.4 Import-Export Values Tab .............................................................. 3-67 
3.5 Import-Export List Tab ................................................................... 3-70 

 

 
This chapter describes how you add (or “commission”) nodes to your 
network and how you design the flow of data throughout the network.  

Note: The functions described in this chapter are available only 
through the network access point.   
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Auto- 
Discovery 

When you configure nodes (described in Chapter 2), you provide them 
with a network ID and a channel. The NAP uses this information to 
“recognize” any nodes which you may subsequently add to the network.   
Once you click Discover (on the Commission tab), the NAP starts 
searching for new nodes, which it adds to the Discovered column on 
that tab (see Section 3.2, Commissioning).   

Design by Drag- 
and-Drop 

 

Simplicity and flexibility are hallmarks of the design of the DRN. 
Selecting the Design tab opens a workspace. On the left of that 
workspace is a device tree representing the nodes defined to the network 
(based on the network ID and channel).  
Click and drag an icon’s label from the tree onto the workspace in the 
right half of the screen. Once an icon is on the workspace, a plus 
appears on the tree next to the icon’s label. Click on the plus sign (+) to 
display all the inputs and outputs available for the selected device. Once 
you have two or more device icons on the workspace, you can select 
inputs and outputs and drag those selections to a device. Arrows help to 
indicate inputs and outputs (see Section 3.3, Designing Data Networks).  

Note: Because you tailor the structure of a particular DRN to your 
geographic site and your reporting requirements, we can only 
present a simple model of a DRN and use it to explain the 
processes for commissioning nodes and designing data 
networks. Consult with your Remote Automation Solutions 
representative to determine the ideal configuration for your 
particular site.    

Importing and 
Exporting Values 

The Import-Export Values tab provides a tabular view of the data 
relationships for individual devices. You can select a device and quickly 
see what data you have defined as inputs to the device and what data you 
have defined as outputs. The Import-Export List tab provides a list of 
the currently defined imports/exports for the entire network. See 
Sections 3.4 and 3.5.   
 

3.1 Displaying Module Information 

Note: ROCLINK 800 displays module information differently 
depending on the device. The FB107 uses a screen with three 
tabs; the ROC800 uses a screen with four tabs.   

3.1.1 Module Information: FB107  
When you click the NRM module on the graphic image of the FB107, 
the tabs in the lower half of the screen change to display the NRM 
options:   
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Figure 3-1. FB107 NRM Tabs 

Tab Description 
General Provides read-only information about the module, 

including build date, boot build date, and any 
module integrity messages. This tab displays when 
you first click the module.   

Network Defines network-specific settings, such as the 
Network ID, Channel, Network Size, and Radio 
Transmit Power.  

Advanced Provides read-only information on noise level, 
radio address, and the current status of the NRM in 
the network.   

Encryption Provides information on the encryption type used 
and the encryption keys. 
Note: This tab appears only if the radios on your 

NRMs are encrypted and you have set 
appropriate security levels.  

Module Information 
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Tab Description 
Configure Click to access the RTU Network screen, which you 

use to commission nodes for the network, design 
the network and view import/export values for 
devices on your network.   

 

General Tab The read-only fields on this tab provide general information about the 
module.   

 

Figure 3-2. FB107 NRM General Tab 

Field  Description 
Installed Module This read-only field shows the name of the module 

currently defined for this slot. ROCLINK 800 does 
not require that a module be physically installed to 
display.   

Description This read-only field shows a 20-character 
description of the module.  

Part Number This read-only field shows the part number of the 
module currently installed.  

Serial Number This read-only field shows the serial number of the 
module currently installed.  

Actual Module This read-only field shows the name of the module 
physically installed in the slot.  

Revision This read-only field shows the firmware revision 
number for the module currently installed.  

Build Date This read-only field shows the date the firmware 
was built for the module currently installed.  

Boot Revision This read-only field shows the version for the main 
startup (“boot”) firmware in the currently installed 
module.  

Boot Build Date  This read-only field shows the build date for the 
main startup (“boot”) firmware in the currently 
installed module.  

Integrity This read-only field shows a message regarding 
the status of the currently installed module.  
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Field  Description 
Uninstall Click to uninstall the currently installed module. The 

Installed Module field displays the type of module 
the FB107 is using for point configuration. 
ROCLINK 800 does not require that the module is 
physically installed in the FB107 to display. The 
FB107 “remembers” the type of installed module 
until you use this button to uninstall it.   

Configure Click to access the RTU Network screen.  
Note: If the FB107 is defined as the network 

access point (NAP), this button accesses 
the RTU Network screen and displays all 
tabs. If the FB107 is defined as a node, this 
button accesses only the Import-Export 
Values tab on the RTU Network screen.   

 

Network Tab Use this tab to define operational parameters for your network:   

 

Figure 3-3. FB107 NRM Network Tab 

Field  Description 
Network ID Defines the specific ID for this network. Valid 

values are 1-254. Do not use 0 as a network ID: it 
turns off the radio on the module. 
Note: The NAP and all nodes on the same 

network must have the same network ID; 
the NAP and all notes on adjacent networks 
must use a different network ID.  

Channel Defines the channel for this network. Click  to 
display all valid values.  
Note: The NAP and all nodes on the same 

network must use the same channel; the 
NAP and all nodes on adjacent networks 
must use a different channel.   

Encryption Type This read-only field shows the encryption strength 
the module uses for communication over the RTU 
network.  Valid values are None or 256 Bit.  
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Field  Description 
Network Size Defines the total number of nodes in the network.  

Note: This field displays only when you configure 
the device as the NAP. 

Radio Transmit 
Power 

Defines, as decibels referenced to one milliwatt, the 
absolute power assigned to this node for 
transmission into the network. Valid values are 0-
27. The mW field displays the milliwatts of power 
the selection represents  
The higher this value, the more power the network 
requires.  

Network Access Point Select this checkbox to configure this device is the 
network access point (NAP). Each network can 
have only one NAP.  
Note: Clear this checkbox to configure this device 

as a node.  
Configure Click to access the RTU Network screen.  
 

Advanced Tab The read-only fields on this tab provide additional information about the 
network.    

 

Figure 3-4. FB107 NRM Advanced Tab 

Field  Description 
Noise Level This read-only field indicates the signal strength of 

this node based on ambient interference. The lower 
the noise level, the clearer the signal.   

Signal Strength This read-only field indicates the signal strength for 
the node’s radio receiver. Valid values are 0 to 127; 
the higher the value the stronger the signal.  
Note: This field displays only if the device is 

configured as a node.  
% Good Packets This read only field indicates the percentage of 

good communication packets the node has 
received since being commissioned. The system 
continually updates this value as it receives 
packets. Valid values are 0 to 100.  
Note: This field displays only if the device is 
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Field  Description 
configured as a node.   

Radio Address This read-only field provides the manufacturer-
provided 7-digit address associated with the radio 
on this module.   

Network Status This read-only field shows the device’s status in 
the network. Valid values are: 

 Initializing Device is being recognized by 
the network. 

 Not Joined Device has been initialized but 
has not joined the network.  

 Joined – Not 
Commissioned 

Device has joined the network 
but is not yet commissioned  

 Joined - 
Commissioned 

Node has joined the network 
and is commissioned.  

Clear Imports and 
Exports 

Click to clear all defined imports and exports from 
the selected device.  
Caution: This action cancels all imports and 
exports from this device, This affects other devices 
on the Distributed RTU Network until you define 
new imports and exports for this device on the 
Design tab of the RTU Network screen (accessed 
through the Network Access Point).   

Configure Click to access the RTU Network screen.  
 

Encryption Tab Use this tab to define the encryption key for NRMs on the network.    

Note: This tab displays only if the radios on your NRMs are encrypted 
and you have set appropriate security levels.    

 

Figure 3-5. FB107 NRM Encryption Tab 

Field  Description 
Encryption Type This read-only field indicates the encryption 

present on the on-board radio. Valid values are 
none or 256 Bit.    
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Field  Description 
Encryption Key (hex) Provides up to eight 8-character hexadecimal 

codes (0 to 9 and A to F) the system uses to 
encrypt data.  
Enter the encryption key you have pre-defined for 
the entire network. The default values are 
00000000; you cannot enter the encryption key 
FFFFFFFF. If you enter fewer than eight characters 
in a field, the system prefixes that value with zeroes 
to ensure the 8-character code (that is, if you enter 
1d, the system completes the field as 0000001d). 
Note: Ensure that the values you enter in these 

fields exactly match the values you enter for 
all nodes and the NAP for this network.   

3.1.2 Module Information: ROC800  
If you install a NRM in a ROC800, you can configure the ROC800 as 
either a node or as the NAP, depending on your network requirements. 
ROCLINK 800 adjusts the number of displayed tabs accordingly.  

ROC800 as a Node Click on the NRM to display the RTU Network screen. The 
Module/Network tab displays by default. You can also select the 
Import-Export Values or Encryption tab.    

 
Figure 3-6. ROC800 Module/Network Tab (as a Node) 
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Field  Description 
Module Type This read-only field shows the name of the module 

currently defined for this slot. 
Description  This read-only field shows a 20-character 

description of the module. 
Flash Part Number  This read-only field shows the part number for this 

module’s flash memory.  
Flash Revision  This read-only field shows the version of the 

module’s flash memory.  
Flash Build Date  This read-only field shows the build date for the 

module’s flash memory 
Serial Number  This read-only field shows the serial number for 

this module.  
Boot Part Number This read-only field shows the part number for the 

module’s boot (start-up) memory.  
Boot Revision This read-only field shows the version of the 

module’s boot memory.  
Boot Build Date  This read-only field shows the build date for the 

module’s boot memory.  
Data This read-only field shows any module-specific 

information.  
System Mode This read-only field shows the module’s interaction 

with the system. Valid values are:   
 Run Mode Module is functioning correctly 

and running.  
 Boot Mode Module is updating the startup 

firmware.  
 Module Failure Module is not functioning 

correctly, is not running, and 
communications may have 
been lost.  

Board Health This read-only field shows the module’s status. 
Valid values are:  

 OK Module is functioning correctly.  
 Module Not 

Installed  
Module is not installed.  

 Module Failure Module is not functioning 
correctly, is not running, and 
communications may have 
been lost.  

Network ID Defines the specific ID for this network. Valid 
values are 1-254. Do not use 0 as a network ID: it 
turns off the radio on the module.  
Note: The NAP and all nodes on the same 

network must use the same network ID; the 
NAP and all nodes on adjacent networks 
must use a different network ID.  
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Field  Description 
Channel Defines the channel for this network. Click  to 

display all valid values.  
Note: The NAP and all nodes on the same 

network must use the same channel; the 
NAP and all nodes on adjacent networks 
must use a different channel.   

Encryption Type This read-only field shows the encryption strength 
the module uses for communications over the RTU 
network. Valid values are none or 256 Bit.   

Network Size Defines the total number of nodes in the network.  
Note: This field displays only when the device is 

the NAP. 
Radio Transmit 
Power 

Defines, as decibels referenced to one milliwatt, the 
absolute power assigned to this node for 
transmission into the network. Valid values are 0-
27. The mW field displays the milliwatts of power 
the selection represents  
The higher this value, the more power the network 
requires.  

Network Access Point Indicates whether this device is the network access 
point (NAP). Each network can have only one NAP. 
This field is blank for a node.   

Noise Level This read-only field shows the signal strength of 
this node based on ambient interference. The lower 
the noise level, the clearer the signal.   

% Good Packets This read-only field indicates the signal strength for 
the node’s radio receiver. Valid values are 0 to 127; 
the higher the value the stronger the signal.  
Note: This field displays only if the device is 

configured as a node.  
Signal Strength  This read only field indicates the percentage of 

good communication packets the node has 
received since being commissioned. The system 
continually updates this value as it receives 
packets. Valid values are 0 to 100.  
Note: This field displays only if the device is 

configured as a node.   
Radio Address This read-only field shows the manufacturer-

provided 7-digit radio address associated with the 
radio installed in this module.   

Network Status This read-only field shows the device’s status in 
the network. Valid values are: 

 Initializing Device is being recognized by 
the network. 

 Not Joined Device has been initialized but 
has not joined the network.  

 Joined – Not 
Commissioned 

Device has joined the network 
but is not yet commissioned  

 Joined - 
Commissioned 

Node has joined the network 
and is commissioned.  
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Field  Description 
Clear Imports and 
Exports 

Click to remove all user-defined imports and 
exports from the selected device.  
Caution: This action cancels all imports and exports 
from this device. This affects other devices on the 
Distributed RTU Network until you define new 
imports and exports for this device on the Design 
tab of the RTU Network screen (accessed through 
the Network Access Point).  

Update Click to save any changed information to the 
configuration.  

 

ROC800 as a NAP Click on the NRM to display the RTU Network screen. The 
Module/Network tab displays by default. A full set of tabs is now 
available for selection, indicating that the ROC800 is configured as the 
NAP.    

 

Figure 3-7. ROC800 Module/Network Tab (as the NAP) 

Note: The remaining tabs – Commission, Design, Import-Export 
Values, Import-Export List, and Encryption – are identical for 
either the ROC800 or FB107.   



Distributed RTU Network Instruction Manual 

3-12 Commissioning and Designing Revised December-2015 

3.2 Commissioning  
Use the Commission tab to commission and decommission devices on 
your data network and to enable pass-through functionality on a per-
device basis.  
Once you have determined the physical structure of your network and 
installed the nodes and the Network Access Point (NAP) for your 
Distributed RTU Network (DRN), you can begin the process of adding 
the network components and determining how data flows through the 
network. Keep in mind that this network is entirely responsive to your 
needs: as your requirements change, you can easily change the flow of 
data between individual notes and the NAP. 

Note: This screen is available only through the Network Access Point, 
If your network access point is a FB107, click Configure and 
then select the Commission tab to access this screen. If your 
network access point is a ROC800, select the Commission tab.   

When you first access this screen after defining the values for your 
NAP, the Discovered column should be empty and the Commissioned 
column should list only the NAP:  

 

Figure 3-8. Undiscovered Network 

Commissioning nodes into the network is a two-step process: 
discovering the nodes and then commissioning them. You cannot 
commission any node until the network access point has first discovered 
it.  

Note: The network access point automatically displays in the 
Commissioned list, but is grayed out (see Figure 3-8). This 
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prevents you from accidentally deleting or decommissioning the 
NAP.  

3.2.1 Discovering Nodes  
You must first discover the odes on your network before you begin 
designing the network.  
To start the node discovery process, click Discover (see Figure 3-8). As 
the NAP “recognizes” nodes (based on the Network ID and Channel 
values you assigned them), it adds them to the Discovered list on the left 
side of the window. A display monitors the progress of the discovery 
process (see Figure 3-9).  

 

Figure 3-9. Discovering Nodes (in Progress) 

You can wait for the discovery process to finish or click Stop 
Discovery once the discovery process has identified all the nodes in the 
network. As Figure 3-10 shows, the program has discovered the nodes 
in this simple network and is ready to commission them.  
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Figure 3-10. Discovering Nodes (Completed) 

3.2.2 Commissioning Nodes  
The commissioning utility enables you to select one or more devices to 
commission at a time.  
1. Left-click a device to select it. To select multiple devices, press 

CTRL and left-click each device. If you are commissioning more 
than one device, your screen might look like Figure 3-11.  

Note: You can also commission devices if you click and drag the 
device names from the Discovered list to the Commissioned 
list.  
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Figure 3-11. Nodes Selected for Commissioning 

2. When you select one or more devices, the Commission button 
activates. Click it to start the commissioning process. Depending on 
the size of your network, this could take several minutes.  

Note: The values in the Comm Status column should automatically 
change to indicate the commissioned status of the nodes. After 
several minutes you may want to click Update to manually 
update the status.   

When the nodes are commissioned, the screen may look like Figure 3-
12:  
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Figure 3-12. Nodes Commissioned 

Field Values Once you commission nodes, the individual read-only fields on this 
screen contain values and are easier to describe.    
 
Field  Description 
Discovered Table lists nodes that the NAP has discovered but 

which have not been commissioned. Fields include: 
 Tag This read-only field shows the device in 

which the NRM is installed. This is the 
device’s Station Name, as defined on the 
Device Information screen (ROC > 
Information). 

 Device ID This read-only field shows a 
manufacturer-provided identification code 
for the NRM. 

Commissioned Table lists devices that are currently commissioned on 
the network. Fields include:  

 Tag This read-only field shows the device in 
which the NRM is installed. This is the 
device’s Station Name, as defined on the 
Device Information screen (ROC > 
Information). 

 Device ID This read-only field shows a 
manufacturer-provided identification code 
for the NRM. 

 Battery This read-only field shows the current 
battery voltage for the node. 
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Field  Description 
 Signal This read-only field shows the signal 

strength for the node’s radio receiver. 
Valid values are 0 to 127; the higher the 
value the stronger the signal.  
Note: As a diagnostic tool, the system 

color-codes this field. Yellow 
indicates marginal signal strength 
values (16-45) and red indicates 
poor signal strength values (0-
15). 

 Noise This read-only field shows the noise 
strength for the node’s radio receiver. 
Valid values are 0 to 127; the higher the 
value the greater the noise.  
Note: As a diagnostic tool, the system 

color-codes this field. Yellow 
indicates marginal noise values 
(31-40) and red indicates 
unacceptable noise values (41-
127). 

 %Good 
Pkts 

This read-only field shows the 
percentage of good communication 
packets the node has received since 
being commissioned. The system 
continually updates this value as it 
receives packets. Valid values are 0 to 
100. 

 Comm 
Status 

This read-only field shows the device’s 
current communication status. Valid 
values are: 

  Good The device is currently 
communicating on the 
network. 

  Commissioning The device is currently 
being commissioned on 
the network. 

  Comm Fail The device is currently 
not communicating with 
the network. 
Note: As a diagnostic 

tool, the system 
color-codes this 
field. Red 
indicates an 
unacceptable 
status (Comm 
Fail) which you 
must resolve. 

 Dev 
Status 

This read-only field shows the device’s 
status. Valid values are Good, Integrity 
(some error exists with the I/O on the 
module), or Fault (an error exists with the 
communications on the module). 



Distributed RTU Network Instruction Manual 

3-18 Commissioning and Designing Revised December-2015 

Field  Description 
  Good The device is not 

reporting any errors. 
  Integrity An error exists on the 

device. 
  Fault An error exists with the 

communications with 
the device. 

  No Update One or more of the 
configured imports has 
failed to update during 
the previous 10 
seconds.  
Note: As a diagnostic 

tool, the system 
color-codes this 
field. Yellow 
indicates a No 
Update 
condition. 

 PassThru ndicates how the NAP handles requests 
from a SCADA system to nodes in its 
network. Click  (which displays when 
you mouse over the right end of the field) 
to select a value.  
Valid values are Enabled (the NAP 
passes SCADA requests through to 
individual nodes) or Disabled (the NAP 
does not pass SCADA requests it 
receives to nodes in its network, although 
individual nodes can respond directly to 
SCADA requests). The default is 
Disabled.  
Note: Refer to Section 1.4, SCADA 

Systems and the Distributed 
Network, for more information. 

 MsgCnt This read-only field shows the number of 
pass-through messages sent to the 
selected device.  

Commission Click to add the nodes selected in the Discovered list 
to the network.  

Discover/Stop 
Discovery 

Click to begin the node discovery process. As the 
NAP “recognizes” nodes (based on the Network ID 
and Channel values you assigned them), it adds them 
to the Discovered list on the left side of the window. A 
display monitors the progress of the discovery 
process. Click Stop Discovery to end the discovery 
process.  
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Field  Description 
Identify/Stop 
Identifying 

Click to cause the NRM’s LEDs to repeatedly flash on 
the device selected in the Decommissioned or 
Commissioned lists. This is useful in identifying a 
device if the tag and device ID are unclear. The 
module’s LEDs continue to flash until you click Stop 
Identifying.  

Decommission Click to remove the node selected in the 
Commissioned list from the network. 

Auto Scan Click to automatically request values from the 
hardware. Click Stop Scan to end automatic 
scanning.  

Update Click to update the contents of the active window from 
the device. 

 
Once you have commissioned devices, you can begin creating the data 
network. Proceed to Section 3.3, Designing Data Networks.  

3.2.3 Color Coding (Commissioned Table) 
The Commissioned table uses color-coding to help you quickly 
diagnose and resolve potential problems with individual network nodes. 
Yellow indicates a marginal condition; red indicates a situation 
requiring resolution.   
As the example screen in Figure 3-13 shows, the third node has 
experienced a communications failure, while the noise levels for the 
first and third nodes may need to be addressed to ensure consistent 
signal strength.   

 

Figure 3-13. Color Coding Error Conditions 

The following table correlates fields and their color values:    
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Field  Color Description 
Signal Yellow indicates marginal signal strength values 

(16-45); red indicates poor signal strength (0-15).  
Noise Yellow indicates marginal noise values (31-40); red 

indicates unacceptable noise values (41-127). 
Comm Status Red indicates an acceptable status (Comm Fail) 

which you must resolve.  
Dev Status Yellow indicates a No Update condition (one or 

more of the configured imports has failed to update 
during the previous 10 seconds).  

3.2.4 De-commissioning Nodes  
Occasionally you may need to decommission a node. This might be 
required if a node fails for some reason or if you need to reconfigure the 
physical location of one or more nodes.   
 

 Caution ALWAYS assume that any node is part of an established data network. 
Document the node’s import and export values so that you can restore 
– if necessary – that node’s functions in the network. If you are 
removing a node, you may need to redefine value imports and exports 
from other nodes to maintain the data flow. Carefully consider all 
aspects of the data network BEFORE you decommission a node.  

 

1. To decommission a node, select it and click Decommission.  

 

Figure 3-14. Node Selected for Decommissioning 

The system displays a warning dialog.  
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2. Click Yes to continue. The system removes the node from both the 

Commissioned list and the design workspace. 

Note: As a result of the decommissioning, the system adds asterisks to 
the labels for all devices on the design workspace, indicating 
that you should click Download Changes to preserve the new 
network configuration. See Section 3.3.7, Saving a Network 
Configuration.   

3.2.5 Re-commissioning Nodes  
Occasionally you may need to replace a non-operating or defective 
node. First you must configure the new node (setting its network ID, 
channel, and radio transmit power definitions for a typical node in the 
network) and then physically replace the defective node in the field. 
You then use ROCLINK 800 to decommission, discover, commission, 
and then download the import and export values for that node.  
1. Access the network 

Start a ROCLINK 800 session and access the network through the 
NAP.  

2. Discover the node 
Click Discover on the Commission screen to locate the new node.  

3. Commission the node 
Drag the newly discovered node onto the Commissioned table and 
place it on top of the listing for the defective node. This tells the 
system that you want the newly discovered node to assume the 
network characteristics of the defective node. This also 
decommissions the defective node. Click Update to apply the old 
node’s value to the new node.  

4. Download the device configuration 
Access the design workspace. Right-click the defective node’s label 
on the device tree and select Download Device Configuration. This 
sends the import and export values for the old node into the new 
node.  

5. Download the network configuration 
Click Download Changes to save your changes to the NCF and 
download the changes to all affected devices in the network.   
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3.2.6 Duplicating Node Configurations  
If you have a number of nodes to configure in the same network, you 
can define one node, copy the .800 configuration file from node, and 
then install that file into other nodes.  
To mass-configure nodes:  
1. Connect to the node having the configuration you want to copy. 
2. Select File > Save Configuration from the ROCLINK menu.  
3. Save the .800 file (use a filename such as “Node_Config” to 

uniquely and easily identify the .800 file).  
4. Attach to the LOI port on the next node.  
5. Select File > Download and select the name of the .800 file from 

step 3.  
6. Click Open. ROCLINK opens the Download Configuration screen.  

 

Figure 3-15. Download Configuration Screen 

7. Select the configuration points to download to the new device, but 
do not download the RTU Network Parameters.  

 

 Caution Do not download the RTU Network Parameters when duplicating nodes. 
Downloading these parameters creates errors on the network.  

 

8. Click Download. ROCLINK copies the indicated configuration file 
into the new node.  

9. Repeat until all nodes are configured.  

Note: Each node must have a unique address and station name. For 
more information, refer to Section 2.2, Configuring Nodes.   
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3.3 Designing Data Networks  
Once you have commissioned nodes, you are ready to begin designing 
data networks.  

Note: This section uses a very simple network, presented to show the 
principles and process of design.   

1. Select the Design tab to display the design workspace (see Figure 3-
16).   

Opening the Design 
Workspace 

The first time you access this tab, ROCLINK 800 displays a dialog 
asking if you want to use an existing Network Configuration file as a 
template for your new network configuration.   

 
Click No to create a new network configuration file or Yes to use an 
existing NCF as a template. For more information, refer to Section 3.8, 
Copying a Configuration File or Section 3.9, Creating Configurations 
Offline.   
The Design Workspace screen is divided in two parts: the left side 
shows the device tree for the network. The device tree shows all of the 
devices currently commissioned on the network. The right side shows 
the design workspace. You use the design workspace to define the data 
relationships between all of the devices on your network. To design a 
network, you drag devices and data points from the device tree to the 
design workspace.   
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Figure 3-16. Blank Design Workspace 

Control  Description 
Device Tree The device tree displays the devices currently 

commissioned on the network. You can drag 
devices from the device tree and place them in the 
design workspace. A plus sign (+) appears next to 
the device name in the design tree after you have 
added it to the design workspace. Click the plus 
sign to see to device parameters you can use to 
configure imports and exports. 

Design Workspace Use the Design Workspace to design your network 
configuration. Drag devices and parameters from 
the device tree on to the design workspace. 

Zoom Move slider to increase or decrease the size of your 
network on the design workspace.   



Distributed RTU Network Instruction Manual 

Revised December-2015 Commissioning and Designing 3-25 

Control  Description 
New Template Click to apply a defined template to the current 

design. This option enables you to quickly copy (or 
“clone”) network designs. You might use this option 
if you were installing a number of identical skids.  
Note: This option destroys any data import and 

export configurations currently defined for 
this network design and replaces them 
with the configurations in the selected 
template. Because of the potential for 
accidental destruction, the system asks you 
to verify your actions several times.  

Update Click to update the device status and health. The 
device name is color-coded to provide you with a 
visual feedback about the health of a device. For 
more information, refer to Color Coding.  

Download Changes  Click to download the current import and export 
configurations to each device.  

 
The device tree on the left side of the workspace shows all the devices 
(NAP and nodes) you have currently defined for the network. The NAP 
is always numbered 1; nodes are numbered 2 to 13 (for a 12-node 
network) or 2 to 25 (for a 24-node network).  
2. Left-click the NAP from the device tree and drag it to the 

workspace:  

 

Figure 3-17. NAP in Design Workspace 



Distributed RTU Network Instruction Manual 

3-26 Commissioning and Designing Revised December-2015 

Figure 3-17 shows the NAP on the workspace. The NAP has a 
yellow border, indicating that it is the currently selected device. The 
program has also expanded the device tree to show available import 
and export values.  

Note: The workspace uses simplified images that do not show 
installed modules.   

3. A network must have a NAP and at least one node. Left-click one of 
the nodes in the device tree and drag it onto the workspace (see 
Figure 3-18). Because the node is now the currently selected device, 
it has the yellow border. The program has also closed the device tree 
for the NAP and opened the device tree for the selected node.   

 

Figure 3-18. NAP and Node in Design Workspace 

4. Repeat the drag-and-drop process to bring all the commissioned 
nodes onto the design workspace.  

3.3.1 Adding Imports and Exports  
The system adds a plus sign (+) next to the device label when you add 
that device to the workspace. To select the “imports” (data values the 
device receives) or “exports” (data values the devices transmits) for a 
device, you need to completely expand the tree to show all the values 
you can select.   
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1. Select the device in the design workspace. The device tree displays 
all the device point categories available to export to another device 
and all currently defined imports and exports (see Figure 3-19).  

 

Figure 3-19. Expanded Values in Device Tree (1) 

Note: Click on the plus (+) sign to expand a device point category 
and display point parameters.  Double-click on the device to 
open the Import-Export Values tab for the device (see 
Section 4.3, Import-Export Values Tab).   

Remember that the labels (such as Discrete Input or Discrete 
Output) are generic. You need to expand the tree further to access 
the specific value you want to select. To do that, click on the plus 
sign next to that value. Figure 3-20 shows the Discrete Output 
further expanded to show several selectable values. 
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Figure 3-20. Expanded Values in Device Tree (2)  

2. In the device tree, select the points you wish to export. Note that 
ROCLINK places a check mark () in the device tree next to each 
parameter you select.  

Notes:  
• To select multiple parameters, hold down the Ctrl key and left-

click each point.  
• To select a range of parameters, select the first parameter in the 

range, hold down the Shift key, and select the last parameter in 
the range.  

• If you select multiple parameters, all selected parameters must 
be located in the same logical. For example, if you select a 
parameter in the first Analog Input logical (#1, P2 Press), you 
cannot also select parameters in the second Analog Input (#2, 
RTD) at the same time.   

3. Drag the selected value(s) to a device. A checkmark appears over a 
valid target device. Since the FB107 node is the currently chosen 
device, the system tags any values we choose as exports from the 
FB107 to the NAP.  
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As Figure 3-21 shows, we select Status from DI #1 and drag it over to 
the NAP. When we “drop” the value onto the NAP, the system adds a 
connection arrow between the node and the NAP (indicating the 
direction of the data flow) and modifies the tree to include the new 
export.   

Note: As you drag the selected value to a device, the program 
identifies a valid target device by placing a check mark over the 
device. If the device is not valid, the program displays an 
international No symbol ()  

 

Figure 3-21. Defined Export (Node to NAP)  

The system creates Import and Export points under each device in the 
device tree:  
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Figure 3-22. Import and Export Points  

Note: The labels for the NAP and node in Figure 3-21 now begin 
with an asterisk (*). The design workspace adds these to 
remind you that you have modified imports and exports for 
these devices. The asterisks appear until you download the 
changed device configurations to the devices (see Section 
3.3.7, Saving the Network Configuration). 

4. Defining an import to the node is just as simple. Select the NAP, 
expand the device tree, and drag-and-drop a value onto the node (see 
Figure 3-23):   
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Figure 3-23. Defined Export (NAP to Node)  

Again, the system modifies the device tree to show the added export. 
Since the NAP is the selected device, we see only the export from the 
NAP to the node. To see the directional data flow of imports and 
exports for all devices, click anywhere other than a device in the design 
workspace. This removes the selection (yellow highlighting) from a 
device and shows all imports and exports (see Figure 3-24).  
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Figure 3-24. Defined Exports and Imports  

5. To build a data network, repeat the process of selecting a device, 
selecting a value, and then dragging that value to the target device. 
Figure 3-25 shows a very simple example data network.  
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Figure 3-25. Defined Data Network  

The network now contains three nodes and a more complex data flow.  

3.3.2 Configuring Data Imports  
You can customize how the system stores data imports on a device. To 
configure an import:  
1. Double-click the device name in the device tree.  
2. Double-click Import in the device tree.  
3. Double-click a specific import in the device tree.  

 
4. Double-click a specific import value in the device tree. The system 

displays the Import Point Configuration screen:  
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Figure 3-26. Import Point Configuration Screen 

Use this screen to modify the configuration parameters for that 
import value. You can modify the Tag, forward to value to a specific 
TLP, enable fault handling, and specify a fault value.  

5. Once you click Apply, the system updates the values displayed in 
the device tree.  

6.  Click Download Changes on the design workspace to download 
the configuration changes to the affected device.  

3.3.3 Duplicating Imports and Exports   
You can reduce the amount of time spent configuring imports and 
exports if you have multiple nodes with similar configurations. When 
you select parameters in the device tree for one device and then select a 
second device on the design workspace, the system automatically 
selects the same parameters in the second device.  
To duplicate selected import/export parameters for multiple devices:  
1. Select the import/export parameters in the device tree for that 

device.  
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Figure 3-27. Parameters Selected, Device 2  

2. Drag the selected parameters from the device tree and place them on 
top of the target device in the design workspace.  

3. Select a new device in the design workspace. Note that all of the 
parameters selected on the first device are automatically selected on 
the second device.  

Note: Both devices must have the same parameters in order for 
this to work.  

 

Figure 3-28. Parameters Selected, Device 3  

4. Drag the selected parameters to the target device.   



Distributed RTU Network Instruction Manual 

3-36 Commissioning and Designing Revised December-2015 

5. Repeat steps 3 and 4 to configure any remaining devices with the 
same import/export parameters.  

6. Click Download Changes on the design workspace to download the 
configuration changes to the affected devices.  

3.3.4 Deleting Imports and Exports   
You may need to delete an import or export from the network. To delete 
an import or export:  
1. Select the Design tab to open the design workspace.   

 

Figure 3-29. Design Workspace 

2. Select the device importing or exporting the data.  

 

Figure 3-30. Design Workspace (Device Selected)  
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3. In the device tree, right-click the import/export you want to remove. 
A pop-up menu displays with a Remove Export from Design option.  

 

Figure 3-31. Remove Export from Design pop-up 

4. Select Remove Export from Design. A confirmation message 
displays.  

 
5. Click Yes to remove the import/export from the network design.   
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Figure 3-32. Export Removed 

6. Click Download Changes on the design workspace to download the 
configuration changes to the affected device.  

3.3.5 Color Coding (Design Workspace)   
The device name (as shown on the design workspace) is color-coded. 
This color-coding provides you with visual feedback about the health of 
the devices, imports, and exports.  
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Figure 3-33. Device Color Coding 

Colors, their meaning, and possible solutions include: 

Color  Description 
Yellow (No Update)  One or more of the import values has not been 

updated in the last 10 seconds. Double-click on the 
device in the design workspace to open up the 
Import-Export Values tab. On the Import-Export 
Values tab, you can find out which device is 
causing the error by looking at the Status column of 
the Imports table. 

Red (Communication 
Failure)  

A communication failure occurs when a device fails 
to communicate with the network for one minute.   

3.3.6 Pop-up Menus  
The device tree and design workspace support several menus you can 
access to streamline work.  

Device Tree Menu If you right-click a network label in the device tree, the system displays 
the following pop-up menu:   
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Figure 3-34. Pop-up Menu: Network Label 

Use this menu to:  

Menu Option  Description 
Download Network 
Configuration to ALL 
Devices 

Clears the imports and exports currently 
defined for the entire network, downloads the 
imports and exports defined in the network 
configuration to each device, and performs a 
warm start on all devices. When you select this 
option, the system displays a warning dialog:  
 

 
You must click Yes to proceed.   
Note: If a device label on the design workspace 

contains an asterisk (*), ROCLINK 800 does 
not allow you to perform this action and 
displays a warning dialog:  

 
Click OK to close this dialog. Then either 
select Download Changes to save any 
pending changes to the affected devices 
(this action saves any changes you have 
made to the network and updates the 
network configuration) or close the RTU 
Network screen completely before retrying 
the download. (This action discards any 
changes and preserves your current network 
configuration.)  
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Device Label Menu If you right-click a device label in the device tree, the system displays 
the following pop-up menu:   

 

Figure 3-35. Pop-up Menu: Device Label 

Use this menu to:  

Menu Option  Description 
Remove Device from 
Design 

Removes the selected device from the design 
workspace. To prevent accidental removals and to 
alert you of the interconnection of a device in the 
network, the system displays a warning dialog:  

 
You must click Yes to proceed.   

Refresh Device Tree  Refreshes the content and available parameters of 
the selected device. This is useful if you make any 
changes to a device, such as installing new 
modules or user programs. 

Download Network 
Configuration to 
Device  

Clears the imports and exports currently defined for 
the device, downloads the imports and exports 
configuration defined in the network configuration, 
and performs a warm start on the updated devices. 
This is useful when replacing a device on the 
network.  
When you select this option, the system displays a 
warning dialog.   

 
You must answer Yes to continue. After 
“refreshing” the device’s configuration, the system 
warm starts the device.  
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Menu Option  Description 
Note: If a device label on the design workspace 

contains an asterisk, ROCLINK 800 does 
not allow you to perform this action and 
displays a warning dialog:  

 
Click OK to close this dialog. Then either 
select Download Changes to save any 
pending changes to the affected devices 
(this action saves any changes you have 
made to the network and updates the 
network configuration) or close the RTU 
Network screen completely before retrying 
the download (this action discards any 
changes and preserves your current network 
configuration). 

 

Design Workspace 
Menu 

If you right-click a device in the design workspace, the system displays 
the following pop-up menu:   

 

Figure 3-36. Pop-up Menu: Design Workspace 

Use these menu options on the design workspace to remotely initiate a 
ROCLINK connection with a node, identify which device is associated 
with a label on the workspace, or remove a device from the network 
design. 

Menu Option  Description 
Remove Device from 
Design 

Removes the selected device from the design 
workspace. To prevent accidental removals and to 
alert you of the interconnection of a device in the 
network, the system displays a warning dialog:  
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Menu Option  Description 

 
Click Yes to proceed.   

Identify Device/ 
Stop Identifying  

Flashes all LEDs on the NRM. This helps you to 
quickly identify a particular NRM on the network. 
You must select Stop Identifying to perform any 
other function with this NRM.  
Note: This option is available only for nodes. 

Connect to Device  Starts a ROCLINK session that connects directly to 
the selected node. This enables you to modify 
configuration details in the selected node.  
To enable this option, you must enable pass-
through messaging for the selected device using 
the Commission tab.  
Note: Do not download firmware, program, or 

display updates to devices over the RTU 
network.   

3.3.7 Saving a Network Configuration   
As you design your network, you should periodically save it by clicking 
the Download Changes button. When you click Download Changes, 
ROCLINK 800 downloads the import/export configurations and warm 
starts all devices.  
To save the network configuration: 
1. Select Download Changes when you have made changes to 

import/export values for one or more devices and you want to save 
those changes to the network configuration file and download those 
modifications to the device. The system saves the changes to the 
configuration file, applies those changes to the device(s), and 
performs a warm start for device(s) with changes. When the process 
completes, the system displays a dialog:  
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2. Click OK. The system removes the asterisks from the labels, 
indicating the changes have been saved and downloaded to the 
devices.   

Note: It is a good idea to save your device configuration file using File 
> Save Configuration. When saving the device configuration for 
a NAP, the system saves a copy of the network configuration 
along with the device data. 

3.3.8 Downloading a Network Configuration   
Use this menu option to clear all defined import and export values for 
all devices in the entire network, download the import and export 
configurations currently defined in the network configuration, and 
perform a warm start to all devices. This option is useful if you have a 
catastrophic failure of numerous network components, and want to 
quickly restore the configuration of an entire network.  
1. Right-click the network label in the device tree. The system displays 

this menu:  

 

Figure 3-37. Pop-up Menu: Network Label 

2. Select this option. The system displays a warning dialog:  

 
3. Click Yes to continue. The system displays a warning dialog:  
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4. Click Yes to continue. The system displays a progress indicator at 

the bottom of the design workspace as it downloads values to each 
device. 

 
5. After downloading values to all devices, the system warm-starts all 

devices and then displays a completion dialog:  
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Note: If a device label on the design workspace contains an asterisk, 
ROCLINK 800 does not allow you to perform this action and 
displays a warning dialog: 
 

 
 
Click OK to close this dialog. Then either select Download 
Changes to save any pending changes to the affected devices 
(this action saves any changes you have made to the network) or 
close the RTU Network screen completely before retrying the 
download (this action discards any changes and preserves your 
current configuration). 

3.3.9 Creating a Network Configuration Template (Offline)  
One of the design features the Distributed RTU Network provides is the 
ability to create a network configuration template when you are not 
connected to a device. This is useful when you have one or more 
standard network configurations you commonly install.  
For example, your organization routinely installs either an 8-node or a 
20-node network, depending on the size of the field and the number of 
wellheads. To streamline the installation process, your installation 
technician can use offline configuration to build a standard template for 
the 8-node and the 20-node network and store those templates on the 
laptop used for installation. 

Notes: 

 Remember that network configuration template resides on the 
laptop used to configure the network, and not on the NAP or any 
component node.  

 The template network and the network you are creating must use the 
same device (ROC800 or FB107) as the NAP. You cannot copy a 
ROC800-based network to a FB107-based network (or vice versa). 

When the need occurs for a new 8-node network, the technician bench-
configures the network nodes and network access point. After installing 
the nodes and network access point in the field, he re-connects to the 
NAP and, when prompted, selects the 8-node template as the model for 
the new network. He directs the program to discover the eight new 
nodes, commissions them by dragging them onto the pre-defined 8-node 
network, and then verifies (or modifies) the import and export values. 
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To create an offline configuration template: 
Start a ROCLINK 800 session, but do not log onto a device. 
1. Open (File > Open) a previously saved .800 configuration file for a 

network access point.  
2. Select the NRM module.  

Note: If your NAP is a FB107, you must click Configure to access 
the Design tab. If your NAP is a ROC800, the RTU Network 
screen opens to the Design tab. 

3. Select the Commission tab. 

 

Figure 3-38. Commission Tab (Offline Configuration) 

Because you are offline, the program changes the names of certain 
screen components. The name of the left-hand column is now 
Network Devices. Additionally, the buttons under the Network 
Devices column are labeled Add Device and Remove Device 
(instead of Discover). Finally, the Commissioned column does not 
have Auto Scan or Update buttons.  

4. Click Add Device. The program opens a Select Configuration Files 
window. 

5. Double-click the configuration file (.800) for a node. The program 
closes the Select Configuration Files window and adds the 
configuration file to the list of Network Devices. 
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6. Repeat the selection process for each node you want to add to the 
configuration. 

 

Figure 3-39. Added Devices (Offline Configuration) 

Note: In our example above, the NAP originally defined only three 
nodes. For our 8-node network template, we add five more 
nodes. We define the imports and exports for our template 
network later.  
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Figure 3-40. Commissioned Devices (Offline Configuration) 

7. Select the Design tab. 
8. Drag the added nodes onto the design workspace and define the 

exports and imports for each network component. 
9. Close the RTU Network screen. A warning displays: 

 
10. Click Yes to save the changes. The system saves the network 

template with a .NCF file extension in the ROCLINK800 subfolder 
on your computer. Network configuration file names are based on 
the Network ID and NAP device type. For example, "N58D-V-
Remote Oprtns Cntrlr.ncf" is the configuration file for a network 
configured to use Network ID 58 with a ROC800 as the NAP, and 
"N42D-V-FB107.ncf" is for a network configured to use Network 
ID 42 with a FB107 as the NAP. 
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Note: To help identify this template for later use, you might want to 
uniquely re-label it (such as N25D-V-ROC-8NodeTemplate.ncf). 

3.3.10 Downloading a Network Configuration Template   
Use this option to download an existing template stored on your PC. 
This option is useful if you have a common network configuration – 
with the same hardware configuration – used for multiple networks.      
 

 Caution Downloading an existing network configuration template clears ALL 
defined import and export value for ALL devices in the entire network, 
downloads the import and export configurations currently defined in 
the network configuration, and performs a warm start to ALL devices. 

 

To download an existing network configuration file template:  
1. After configuring the network ID and channel on all devices 

belonging to the network, select the Design tab on the network 
access point.  

 

Figure 3-41. Design Tab screen 

2. Click New Template. The system displays a warning dialog:  
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3. Click Yes to continue. The system displays a Select Template File 

screen:  

 

Figure 3-42. Select Template File screen 

This screen lists all copies of network configuration files (.NCFs) 
defined in the ROCLINK800 folder (the default location for these files).  

Note: The system names network configuration files based on the 
Network ID and NAP device type. For example, N58D-V-
Remote Oprtns Cntrlr.ncf is the configuration file for a network 
configured to use Network ID 58 with a ROC800 as the NAP, 
and N42D-V-FB107.ncf is the network configuration file for a 
network configured to use Network ID 42 with an FB107 as the 
NAP.  

Select a network configuration file and click Open. Remember that the 
type of controller (FB107 or ROC800) must match the NAP controller 
type in the new network.  
4. The system displays a warning dialog:  
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5. Click OK. The system displays the Design tab showing your new 

network configuration:  

 

Figure 3-43. Design Workspace screen 

Note: Note that the devices show communications failures. You 
must re-commission your devices and download all changes 
to ensure proper network functionality.   

6. Select the Commission tab and click Discover. Once the program 
locates all the nodes associated with your new network, click Stop 
Discovery.  
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Figure 3-44. Commissioned screen (with devices) 

7. Click and drag a node in the Discovered list on top of a node in the 
Commissioned list. The program displays a warning dialog: 

 

Note: The node in the Discovered list and the node in the 
Commissioned list must have exactly the same hardware 
installed in exactly the same slots to allow proper 
configuration of imports and exports.    

8. Click Yes. This enables the new node to assume the same export 
and import values you defined for the original network. (You can 
always change these values later.) When the node is commissioned, 
the screen removes the blue highlighting and provides the node’s 
device ID:   
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Figure 3-45. Commissioned Device screen 

Note: You must repeat this drag-and-drop  process for each device. 
Because of the import and export definitions, the program 
does not allow a “mass” drag-and-drop.     

9. Repeat the drag-and-drop for each device. When you are finished, 
the highlighting is gone and each node has a device ID:   

 

Figure 3-46. Commissioned Device screen 

10. Select the Design tab, which displays the design workspace and 
shows the imports and exports defined for your new network.  
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Figure 3-47. Design Workspace screen 

11. Click Download Changes to save the new network configuration to 
the NAP.  

12. Right-click the network label in the device tree; the system displays 
the following menu:  

 
13. When you select this option, the system displays a warning dialog:  

 
14. Click Yes to continue. The system displays an additional warning 

dialog:  
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15. Click Yes to continue. The system displays a progress indicator at 

the bottom of the design workspace as it downloads values to each 
device.   

 
16. After downloading values to all devices, the system warm starts all 

devices and then displays a completion dialog:  

 

Note: If a device label on the design workspace contains an 
asterisk, ROCLINK 800 does not allow you perform this 
action and displays a warning dialog. 
 

 
 
Click OK to close this dialog and select Download Changes 
to save any pending changes to the affected devices before 
attempting to download the network configuration to all 
devices.   

17. Click OK to complete the process and return to the Design tab.  
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Note: At this point you can review the defined imports and exports 
and make any adjustments necessary for that particular 
network. Remember that you can click the Import-Export 
Values tab to quickly review these values for each device.    

3.3.11 Copying a Network Configuration (Online)  
If you need to install several RTU networks that are fundamentally the 
same (that is, they use same controller as a NAP and approximately the 
same number of nodes), you can speed the creation process by using an 
existing network configuration as a template.   

Note: The template network and the network you are creating must 
have the same device (ROC800 or FB107) as the NAP. You 
cannot copy a ROC800-based network to a FB107-based 
network (or vice versa). 

1. Save the configuration of the network you want to use as a template. 

Note: ROCLINK automatically places a copy of the saved network 
configuration into the ROCLINK800 folder on your 
computer. This copy uses the file extension .NCF.  

2. Connect to each device on the new network and configure its 
Network ID, Channel, and Radio Transmit Power values. 

Note: Configure the NAP last. 

3. Close the ROCLINK 800 session, and reconnect to the NAP. When 
you access the NAP, the program displays a dialog: 

 
Note: Click No only if you want to totally recreate the network. 

4. Click Yes. The program displays a Select Template File screen:  
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Figure 3-48. Select Template File screen 

This screen lists all copies of network configurations (.NCFs) 
defined in the ROCLINK800 folder (the default location for 
these files). 

Note: The system names copies of a network configuration 
based on the Network ID and NAP device type. For 
example, N58D-V-Remote Oprtns Cntrlr.ncf is the 
configuration file for a network configured to use 
Network ID 58 with a ROC800 as the NAP, and N42D-V-
FB107.ncf is for a network configured to use Network ID 
42 with a FB107 as the NAP. 

Select a network configuration file and click Open. Remember 
that the type of controller (FB107 or ROC800) must match the 
controller in the new network. The program displays the RTU 
Network screen, showing the Module/Network tab. 
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Figure 3-49. Design tab 

5. Select the Commission tab.  

 

Figure 3-50. Commission screen 

Notice in the Commissioned list that the three FB107 nodes are 
highlighted in blue and that the Device ID for each device is a 
question mark (?). This indicates that the program has used another 
network’s template but the definitions for those nodes are no longer 
valid.  

6. Click Discover. Once the program locates all the nodes associated 
with your new network, click Stop Discovery. 
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Figure 3-51. Commission screen (with Devices) 

7. Click and drag a node in the Discovered list on top of a node in the 
Commissioned list. The program displays a dialog: 

 

Note: The node in the Discovered list and the node in the 
Commissioned list must have exactly the same hardware 
installed in exactly the same slots to allow proper 
configuration of imports and exports.  

8. Click Yes. This enables the new node to assume the same export 
and import values you defined for the original network. (You can 
always change these values later.) When the node is commissioned, 
the screen removes the blue highlighting and provides the node’s 
device ID: 
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Figure 3-52. Commission Device screen (1) 

Note: You must repeat the drag-and-drop for each device. Because 
of the import and export definitions, the program does not 
allow a “mass” drag-and-drop. 

9. Repeat the drag-and-drop for each device. Because of the import and 
export definitions, the program does not allow a “mass” drag-and-
drop. When you are finished, the highlighting is gone and each node 
has a device ID: 

 

Figure 3-53. Commission Device screen (2) 
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10. Select the Design tab, which displays the design workspace and 
shows the imports and exports defined for your new network. 

 

Figure 3-54. Design Workspace 

11. Click Download Changes to save the new network configuration 
and download the import/export definitions into the NAP and nodes.  

Note: At this point you can review the defined imports/exports and 
make any adjustments necessary for this particular network. 
Remember that you can click the Import-Export Values tab 
to quickly review these values for each device. 

Repeat this process as necessary to create the networks you need. 

3.3.12 Restoring a Single Device Configuration   
You can restore the input and output configurations for a single device 
on your network. This is useful if a device experiences a hardware 
failure or you completely replace the device.  
To restore the configuration of a single device:  
1. Verify the device being restored is configured with the correct 

Network ID and channel. 
2. Connect to the NAP using ROCLINK 800. 
3. Open the RTU Network screen and select the Design tab. 
4. Right-click the device label in the device tree of the device you wish 

to restore. The system displays the following menu: 
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Figure 3-55. Pop-up Menu: Device Tree 

5. Select Download Network Configuration to Device. The system 
displays a warning dialog: 

 
6. Click Yes to continue, The system displays a warning dialog:  

 
7. Click Yes to continue. The system displays a progress indicator at 

the bottom of the design workspace as it restores values to each 
device.  

 
8. After downloading values to all devices, the system warm starts all 

devices and then displays a completion dialog: 
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Note: If a device label on the design workspace contains an asterisk, 
ROCLINK 800 does not allow you to perform this action, and 
displays a warning dialog:  
 

 
 
Click OK to close this dialog. Then either select Download 
Changes to save any pending changes to the affected devices 
(this action saves any changes you have made to the network) or 
close the RTU Network screen completely before retrying the 
download (this action discards any changes and preserves your 
current configuration). 

3.3.13 Restoring an Entire Network Configuration  
You can restore the entire network to a previously saved state. The 
system saves the network configuration file as part of the device 
configuration file (.800) when you save the configuration of the NAP 
(File>Save Configuration). You can use this file to restore all 
input/output configurations for all devices on the network.  
1. Connect to each node using ROCLINK 800 and verify all devices 

are configured with the correct Network ID and channel. 
2. Connect to the NAP using ROCLINK 800. 
3. Select File>Download to load the previously saved configuration 

file (.800) that contains the correct network configuration. 
4. Click Select All to select all points in the configuration file to be 

downloaded. 
5. Click Download to begin downloading the configuration to the 

device. 
6. Select Close when the download completes. 
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7. Select the NRM module and click Configure. The RTU Network 
displays showing the Design tab. 

8. Right-click the network label in the device tree. The system displays 
the following menu: 

 

Figure 3-56. Pop-up Menu: Network 

9. Select this option. The system displays a warning dialog: 

 
10. Click Yes to continue. The system displays a warning dialog: 

 
11. -Click Yes to continue. The system displays a progress indicator at 

the bottom of the design workspace as it restores values to each 
device.  
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12. After downloading values to all devices, the system warm starts all 
devices and then displays a completion dialog: 

 

Note: If a device label on the design workspace contains an asterisk, 
ROCLINK 800 does not allow you to perform this action, and 
displays a warning dialog: 
 

 
 
Click OK to close this dialog. Then either select Download 
Changes to save any pending changes to the affected devices 
(this action saves any changes you have made to the network) or 
close the RTU Network screen completely before retrying the 
download (this action discards any changes and preserves your 
current configuration). 
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3.4 Import-Export Values Tab  

Note: If your network access point is a FB107, click Configure and 
then select the Import-Export Values tab to access this screen. 
If your network access point is a ROC800, select the Import-
Export Values tab.   

This screen provides a read-only table that lists the current import and 
export values for a selected device (either node or NAP). The system 
updates these real-time values whenever you display this screen.  

Notes: 

 If the connected device is configured as a node, the Device drop- 
down list only contains the currently connected device. If the 
connected device is configured as a NAP, the Device drop-down 
list contains every device on the network.  

 All Import/Export configuration is done on the design tab. You 
cannot change the values on this tab. 

 

Figure 3-57. Import-Export Values screen 

If you have selected a device on the design workspace, this screen opens 
displaying the values for that device. If you have not selected a device 
on the design workspace, this screen opens displaying the values for the 
NAP.   
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Note: You can also access this screen by double-clicking on a device 
on the design workspace.   

 
Field  Description 
Device Click  to select a device on your network and 

display all import and export configurations for the 
selected device.  

Imports This read-only table shows all data points being 
imported to the selected device. The table includes: 

 Import From 
Device 

Shows the device description 
from which the import data is 
originating. The description is 
comprised of a number (the 
device location in the table on the 
Commission tab) and the device 
tag. 

 Import Point Shows the data point in the 
source device that is being 
imported to the selected device. 

 Forward TLP Shows the TLP to which the 
imported data is being forwarded. 

 Value Shows the current value of the 
import data point. 

 Status Shows the current condition of 
the import data point. Valid 
values are: 

  Good The import data point 
condition is good.  

  No 
Update 

The selected device 
has failed to return a 
value for the import 
during the previous 10 
seconds. 

  Point 
Alarm 

The data point is 
currently reporting an 
active alarm (for 
example, an analog 
input is reporting a low 
alarm).  

  Point 
Fail 

The hardware of the 
source device is 
reporting a 
malfunction. 

Exports This read-only table shows all data points being 
exported from the selected device. The table 
includes: 

 Export to 
Device 

Shows the device description for 
to which the export is being sent. 
The description consists of a 
number (the device location in 
the table on the Commission tab) 
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Field  Description 
and the device tag. 

 Export Point Shows the data point being 
exported to the selected device. 

 Value Shows the current value of the 
export data point. 

Auto Scan Click to begin a real-time once-per-second 
continual update of the displayed values. The 
update continues until you click Stop Scan. During 
Auto Scan you cannot select another device. 

Update Click to immediately update the display to the 
values obtained in the last once-per-period system 
scan.  
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3.5 Import-Export List Tab  

Note: If your network access point is a FB107, click Configure and 
then select the Import-Export List tab to access this screen. If 
your network access point is a ROC800, select the Import-
Export List tab.   

This screen is a table that lists the assigned import and export values for 
all devices in the network (either node or NAP). You cannot change 
these values.  

Notes:  

 This tab is only available through the Network Access Point. 
 All Import/Export configuration is done on the Design tab. You 

cannot change the values on this tab. 

 

Figure 3-58. Import-Export List Tab 
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Field  Description 
Source This read-only field shows the device originating 

the import data. The description consists of a 
number (the device location in the table on the 
Commission tab) and the device tag.  

Export TLP This read-only field shows the data point of the 
import in the originating device.   

Export Tag This read-only field shows the name associated 
with the data point of the import in the originating 
device. 

Destination This read-only field shows to which device the 
import data is being sent. The description contains 
a number (the location of the device in the table on 
the Commission tab) and the device tag. 

Forward TLP This read-only field shows the TLP to which the 
import data is sent.   

Fault Enable  This read-only field shows if a fault value has been 
enabled for the selected export. If enabled and a 
point failure occurs, the system uses this value set 
in the Fault Value field for the selected export 
value.  

Fault Value This read-only field shows the user-entered value 
for the selected export.   

Sort by Source 
Device 

Select to sort the table according to the source 
device of the exported data.  

Source by 
Destination Device 

Select to sort the table according to the destination 
device of the exported data. 

Print Preview Click to print the list or export it to a file. When the 
Print Preview screen appears, click Print to send 
the list to a printer. You may also set the PDF, 
Excel, Txt, HTML or RTF buttons to export the list 
as a file in those formats. 

Auto Scan Click to begin a real-time once-per-second 
continual update of the displayed values. The 
update continues until you click Stop Scan. During 
Auto Scan you cannot select another device.  

Update Click to immediately update the display to the 
values obtained in the last once-per-second system 
scan.  

 
Creating this template allows the technician to quickly configure a 
network based on a standardized format. Of course, the technician can 
remove or add imports and exports based on the specific requirements 
for the individual network, but using a network template speeds the 
initial installation process.   
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Chapter 4 – Troubleshooting 

This chapter provides techniques and procedures you can use to resolve 
challenges with your Distributed RTU network.   

Note: Because the structure of any particular DRN is tailored to your 
specific geographic site, we can only present an idealized model 
of a DRN and use it to explain the processes of installing, 
configuring, and commissioning. Consult with your Remote 
Automation Solutions representative to determine the optimal 
configuration for your particular site.    

In This Chapter 

4.1 Planning the Network ............................................................................. 4-1 
4.1.1 Case 1: 21-Node Network .......................................................... 4-1 
4.1.2 Case 2: Multi-well Pad with one Node per Eight Wells .............. 4-2 
4.1.3 Mapping the Network ................................................................. 4-3 
4.1.4 System Security ......................................................................... 4-4 

4.2 Configuring Nodes ................................................................................. 4-5 
4.2.1 Configuring a ROC800 or FB107 as a Node .............................. 4-7 

4.3 Field Installation ..................................................................................... 4-8 
4.4 Calculating Power Requirements .......................................................... 4-8 
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4.1 Planning the Network  
You can install the DRN either with a maximum of 12 nodes or with a 
maximum of 24 nodes. Which version you install is based on how you 
anticipate data should flow through the network.  
Review Figure 2-1 and Figure 2-2. Both show the same physical 
wellpad structure configured in two different ways.  

4.1.1 Case 1: 21-Node Network  
Figure 2-1 shows a 16-well pad with one node per well. Each separator 
(with its own meter run and flow value) is wired to its own flow 
computer (a ROC800 or FB107). Each flow computer has an installed 
Radio Network module (NRM). An additional node provides data from 
the storage tanks. Using 21 nodes, this network also shows the network 
access point (NAP), peer-to-peer, many-to-one, and one-to-many data 
relationships (which you define when you configure the network).   
1. Network access point (NAP): Field Tools permits access and storage 

of configuration data from all the DRN nodes.  
2. Many-to-one data flow: a single node can receive data from multiple 

nodes in the network at each update period. Information from the 
individual production wells flows to the RTU.  
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3.  Peer-to-peer network: any node can receive or send data to any 
other node in the network without passing through the Network 
Access Point. Information flows between RTUs.  

4. One-to-many data flow: one node within the network can send data 
to multiple other nodes each update period. Information from the 
storage tanks flows to each RTU.  

 
1 Network access point (NAP) 
2 Many-to-one data flow 
3 Peer-to-peer network 
4 One-to-many data flow 

Figure 4-1. 21-Node Network: Multi-well Pad with One Node per Well 

4.1.2 Case 2: Multi-well Pad with one Node per Eight Wells  
Figure 4-2 shows the same physical well pad as in Figure 4-1 but 
structured as a 7-node network. In this case a node acquires data from 
eight wells (grouped as a pit). Each node then communicates with two 
RTUs.  
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1 Network access point (NAP) 
2 Many-to-one data flow 
3 Peer-to-peer network 
4 One-to-many data flow 

Figure 4-2. 7-Node Network: Multi-well Pad with One Node per Eight Wells 

4.1.3 Mapping the Network  
By mapping out your network before you install any nodes, you can 
anticipate and resolve potential issues (such as locations which might 
need an antenna mast, placement of solar panels, and so on) as well as 
streamline the actual installation process. As Figures 4-1 and 4-2 show, 
the DRN is flexible enough to accommodate a variety of physical 
configurations. Additionally, you can add and field-configure nodes 
(within the limitations for your chosen DRN size) as your data needs 
change, as well as change how data flows through the network.   

Note: For further information on power requirements, refer to the 
product data sheets FB107:DRN, FB107:NRM, or 
ROC800:NRM. For further information on how to optimally 
locate nodes for maximum communication, refer to Appendix B, 
Optimizing Wireless Communications.  
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4.1.4 System Security  
You want a SCADA system to transparently access all the nodes in your 
network. Alternately, you may want to restrict access if technicians need 
to service individual nodes. The Distributed RTU Network can provide 
both the transparency and the restrictions you require, and you can 
change these settings as your requirements change. Figure 4-3 presents 
a simple usage scenario.  

 

Figure 4-3. DRN Security 

In this scenario, the SCADA system uses the Comm2 port, for which 
security has been disabled. Any messages from Comm2 pass 
immediately to the nodes and vice versa.  
On the other hand, a technician connects to the NAP using the LOI, for 
which User ID level-security has been enabled. Similar, each node also 
has User ID level-security enabled. For Node A, the correct User 
ID/password is JOE/1234. For Node B, the correct User ID/password is 
DAV/5678.   
This arrangement permits technician JOE (using the “Connect to 
Device” option) to log onto Node A with secure over-the-air access. If 
JOE tries to access Node B using JOE/1234, Node B rejects the attempt. 
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Only technician DAV using password 5678 can successfully access 
Node B.  

Note: Remember that the position of the NRM dictates the comm port 
used. Placing the NRM in slot 1 activates Comm3; placing the 
NRM in slot 2 activates Comm2. This example assumes the 
NRM is placed in slot 1 of the nodes.   

Defining 
Accesses 

You define these communication port-based security settings using the 
Device Security screen in ROCLINK 800.   
Select ROC > Security on the ROCLINK toolbar to display the Device 
Security screen:  

 

Figure 4-4. Device Security (FB107) 

Select the User ID Enabled option for the appropriate communication s 
port, define the technician’s ID and password, and click Apply.   

4.2 Configuring Nodes  
Once you have determined the size of your DRN, assemble your nodes. 
You need to configure each node individually with four pieces of 
network-specific information: Network ID, Channel, Radio Transmit 
Power, and whether the node is a network access point.   

Note: Although you can field-configure nodes, it may be easier to 
perform the configuration on a bench or other protected location.   

To configure a node, you need a PC running ROCLINK 800 (Version 
2.10 or higher). Connect to the node using the LOI port and start 
ROCLINK. Once ROCLINK starts, click on the Network Radio module 
to display the NRM configuration screens. Select the Network tab to 
display the network configuration values:  
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Figure 4-5. Node Configuration Screen 

Complete the following fields:  

Field  Description 
Network ID Enter a valid Network ID (between 0 and 255). The 

network ID identifies all the devices (nodes and 
network access point) belonging to that network, so 
all devices on a network must have the same 
network ID.  

Channel Enter a valid channel (between 0 and 14). As with 
the network ID, all devices belonging to the same 
network must have the same channel.   

Encryption Type This display-only field shows the encryption type 
of the on-board radio. Valid values are none or 256 
bit.  

Radio Transmit Power Indicates, in decibels of measured power, the 
relative strength of the radio signal for this node. 
Although all nodes in a network typically have the 
same value for this field, you can adjust this value 
to “boost” the signal for nodes in more remote or 
less-than-optimal situations.  
The system calculates the draw in mW and 
completes this field based on the value you enter.  
Note: The higher the value in this field, the more 

power the node draws from its battery when 
it transmits data.  

Network Access Point Leave this check box blank for nodes.  
Configure Click to apply the indicated values to the node.  
 

Duplicating Node 
Configurations 

If you have a number of nodes in the same network to configure, you 
can define one node, copy the .800 configuration file from that node, and 
then install that file into other nodes.   

To mass-configure nodes:  
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1. Select File > Save Configuration from the ROCLINK menu.  
2. Save the .800 file. (Use a filename such as “Node_Config” to 

uniquely identify the .800 file.)   
3. Attach to the LOI port on the next node.  
4. Select File > Download and select the name of the .800 file from 

step 2. 
5. Click Open. ROCLINK copies the indicated configuration file into 

the new node.    
6. Repeat until all nodes are configured.  

Addressing 
Nodes 

All devices in a Distributed RTU Network must belong to the same 
group. Additionally each device in a network must have its own unique 
address. (Essentially, the group number identifies the network “family,” 
while the address is the individual device’s “given” name.)    
To check the group and address for a device, select ROC > 
Information from the ROCLINK 800 menu bar. The Device 
Information screen displays.   

 

 

Figure 4-6. Device Information Screen (ROC800 and FB107) 

As shown in Figure 4-6, the NAP (here, a ROC800) and the node share 
group 2; the NAP uses address 1 and the node uses address 2.  

4.2.1 Configuring a ROC800 or FB107 as a Node  
If required for your organization’s data needs, you can install a Network 
Radio module in a ROC800 or FB107 already in the field and define 
that ROC800 or FB107 as a node in a network.  

Note: You must install the NRM in a communications slot on the 
ROC800 (slot 1, 2, or 3) or FB107 (slot 1 or 2). 

Connect a laptop to the LOI port on the ROC800 or FB107 and start 
ROCLINK 800. Click on the image of the NRM to begin the 
configuration process. As shown in Figure 4-5, use the Network tab for 
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a FB107. For a ROC800, the configuration information appears on the 
Module/Network tab.   
Provide the same information (Network ID, channel, and Radio 
Transmit Power) as for any other node on the same network. Click 
Apply to save the network configuration values to the NRM.  

4.3 Field Installation  
Once you have configured all nodes, you can perform the field 
installation. Refer to the site map you have prepared indicating the 
location of all nodes, as well as power requirements (DC, battery, or 
solar panels).  
Bench-configure the individual nodes with ROCLINK 800, identifying 
the Network ID, Channel, Radio Transmit Power, and yes/no to 
Network Access Point. Attach to the LOI port on node, start ROCLINK 
800, and access the Module/Network tab.  

4.4 Calculating Power Requirements  
Because you place the Distributed RTU Network in an isolated 
environment, device autonomy – how long a device can function solely 
on either battery or solar power – is an essential operational concern.  
 

 Caution Temperature and other environmental conditions can affect how a 
battery or solar panel functions. Adjust any autonomy requirements 
and calculations based on site conditions.  

 

Table 4-1assumes a typical FloBoss 107 Distributed RTU Network 
bundle: a four-slot FB107 chassis loaded with a Distributed RTU 
Network CPU (non-isolated with on-board I/O) and a Network Radio 
module.  

Table 4-1. Module Power Information 

 
 

Slot 

 
 

Module Description 

 
Base Idle 
(No Load) 

 
Max Active  
(Full Load) 

 
Loading  
Factor 

 
Module Power 

in mW 
0 CPU Non-isolated with I/O  396 mW 476 mW 100% 476 
1a Network Radio Module  

(non-encrypted) 
288 mW 720 mW 100% 720 

1b Network Radio Module 
(encrypted) 

398 mW 1152 mW 100% 1152 

2 empty -- -- --  
3 empty -- -- --  

Totals (with unencrypted NRM) 684 mW 1196 mW 100% 1196 
Totals (with encrypted NRM) 794 mW 1628 mW 100% 1628 
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Note: If you choose to install additional modules (such as a 6-point I/O 
module), refer to Determining Power Consumption in Chapter 3 
of the FloBoss 107 Flow Manager Instruction Manual (part 
D301232X02) for additional power requirements. 

Following is the worksheet to determine power requirements:  

Table 4-2. Blank Power Consumption Worksheet 

Power   
Field Power (mW) ----   

Total Power ---- 
Voltage   

Input Voltage (V dc) ----   
Current   

System Current mA ----   
Communications mA (Average) ----   

Total Current mA on Power System ----  
Miscellaneous   

Battery Voltage ----   
Battery Capacity Amp/Hour ----   

Depth of Discharge ----   
Available Hours ----   

Days of Autonomy ----   
 

A Field Power is sum of the active load values for all modules  
B Total Power is the maximum active load of all modules at all times.  
C Voltage indicates the input voltage of the power source (in this case, typically a 12 Vdc 

battery)  
D Total Current mA on Power System represents the Total Power value (B) divided by 

the Voltage value (C), expressed as mA. 
Note: When applicable, this value would also take into consideration any external current 
through communications devices.  

E Miscellaneous represents several components: 
 Battery Voltage A given value from the battery manufacturer  
 Battery Capacity A given value in Amp/Hr from the battery manufacturer  
 Depth of Discharge Maximum percentage of discharge for the battery  
 Available Hours Number of hours the unit can be powered without external 

charging of the power system. This value is the battery capacity (in 
Amp/Hrs) divided by the Total Current mA on Power System 
value.   

 Days of Autonomy Available hours divided by 24.  
 
Using the values presented in Table 2-1 for an unencrypted module, the 
completed Power Consumption worksheet looks like this:   

B 
C 

D 
E 

A 
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Table 4-3. Completed Power Consumption Worksheet 

Power   
Field Power (mW) 1196   

Total Power 1196 
Voltage   

Input Voltage (V dc) 12   
Current   

System Current mA 99.7   
Communications mA (Average) 0   

Total Current mA on Power System 99.7 
Miscellaneous   

Battery Voltage 12 v   
Battery Capacity Amp/Hour 7 x .80 = 5.6   

Depth of Discharge 80%   
Available Hours 56.17   

Days of Autonomy 2.34   
 

A 476 mW + 720 mW = 1196 mW 
B 1196 mV 
C 12 V 
D 1196 / 12 = 99.666667 
E  7 Amp/Hr x .80 (depth of discharge) = 5.6 Am/Hr =  
 80% (100% - 20% reserve) 
 (5.6  / 99.7) x 1000 (conversion from mW to W) = 56.17 
 56.17 / 24 = 2.34 days of autonomy 

 
Based on this example, we can expect the Distributed RTU to operate 
for a little more than two days without supplemental power. Use the 
worksheet to proactively anticipate power needs and meet them to keep 
your system operational.  

4.5 Removing a Node from the Network  
If you decide to remove a node from your network, be sure to 
decommission that node before removing it. Otherwise the system 
generates a series of error messages warning you about the absence of 
the node. To resolve this situation, reinstall the node, recommission and 
then decommission it, and then remove the node.  
 

B 
C 

D 

E 

A 
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Appendix A – Glossary 

Note: This is a generalized glossary of terms. Not all the terms may 
necessarily correspond to the particular device or software 
described in this manual. For that reason, the term “ROC” is 
used to identify all varieties of Remote Operations Controllers 
(including ROC800-Series, ROC800L, DL8000, FloBoss™ 
107, and FloBoss™ 100-Series). Refer to Measurement Units, 
Symbols, and Abbreviations (Form A6302) for additional 
information.  

A 
A/D Analog to Digital signal conversion.  
ABS Acrylonitrile Butadiene Styrene. 
ADC Analog to Digital Converter. Used to convert analog inputs (AI) to a format the flow 

computer can use.  
AGA American Gas Association. A professional organization that oversees the AGA3 

(orifice), AGA5 (heating value), AGA7 (turbine), AGA8 (compressibility), and AGA11 
(ultrasonic) gas flow calculation standards. See http://www.aga.org. 

AWG American Wire Gauge. 
AI Analog Input. 
AO Analog Output. 
Analog Analog data is represented by a continuous variable, such as an electrical current 

signal. 
AP Absolute Pressure. 
API American Petroleum Institute. See http://www.api.org. 
Area A user-defined grouping of database entities.  
ASCII American (National) Standard Code for Information Interchange. 
Attribute A parameter that provides information about an aspect of a database point. For 

example, the alarm attribute is an attribute that uniquely identifies the configured value 
of an alarm. 

B 
BMV Base Multiplier Value, used in AGA7 (turbine) calculations.  
BPS Bits Per Second, associated with baud rate. 
BTU British Thermal Unit, a measure of heat energy. 
Built-in I/O I/O channels that are fabricated into the ROC and do not require a separate option. 

Also called “on-board” I/O. 

C 
C1D2 Class 1, Division 2 hazardous area 
CMOS Complementary Metal Oxide Semiconductor, a type of microprocessor used in a ROC. 
Coil Digital output, a bit to be cleared or set.  
COL Ethernet Packet Collision. 
COM Communications port on a personal computer (PC).  
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C (continued) 
COMM Communications port on a ROC used for host communications. .  

Note: On FloBoss 500-Series and FloBoss 407s, COMM1 is built-in for RS-232 serial 
communications.  

Comm Module Module that plugs into a ROC to provide a channel for communications via a specified 
communications protocol, such as EIA-422 (RS-422) or HART. 

CF Compare Flag; stores the Signal Value Discrete (SVD).  
Configuration Refers either to the process of setting up the software for a given system or the result 

of performing this process. The configuration activity includes editing the database, 
building schematic displays and reports, and defining user calculations. Typically, the 
software setup of a device that can often be defined and changed. Can also mean the 
hardware assembly scheme. 

Configuration 
Tree 

In ROCLINK 800, the graphical display that appears when a configuration file opens. It 
is a hierarchical branching (“tree-style”) method for navigating within the configuration 
screens.  

CPU Central Processing Unit. 
CRC Cyclical Redundancy Check error checking. 
Crosstalk The amount of signal that crosses over between the receive and transmit pairs, and 

signal attenuation, which is the amount of signal loss encountered on the Ethernet 
segment. 

CSA Canadian Standards Association. See http://www.csa.ca. 
CSMA/CD Carrier Sense Multiple Access with Collision Detection. 
CTS Clear to Send modem communications signal. 

D 
D/A Digital to Analog signal conversion.  
DB Database. 
dB Decibel. A unit for expressing the ratio of the magnitudes of two electric signals on a 

logarithmic scale. 
dBm Power ratio in decibels (dB), referenced to one milliwatt (mW), also known as dBmW. 
DCD Data Carrier Detect modem communications signal. In addition, Discrete Control 

Device – A discrete control device energizes a set of discrete outputs for a given 
setpoint and matches the desired result against a set of discrete inputs (DI).  

DCE Data Communication Equipment. 
Deadband A value that is an inactive zone above the low limits and below the high limits. The 

purpose of the deadband is to prevent a value (such as an alarm) from being set and 
cleared continuously when the input value is oscillating around the specified limit. This 
also prevents the logs or data storage location from being over-filled with data. 

Device 
Directory 

In ROCLINK 800, the graphical display that allows navigation through the PC Comm 
Ports and ROC Comm Ports setup screen.   

DI Discrete Input. 
Discrete Input or output that is non-continuous, typically representing two levels (such as on/off). 
DMM Digital multimeter.  
DO Discrete Output. 
Download The process of sending data, a file, or a program from a PC to a ROC. 
DP Differential Pressure. 
DRN Distributed RTU Network, in which two or more remotely distributed RTU devices 

(RRTUs) are wirelessly connected in a peer-to-peer network to share data.  
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D (continued) 
DRTU A primary component of the Distributed RTU Network, consisting of a FB107 chassis 

housing a focused functionality CPU and a Network Radio module (NRM). The DRTU 
collects process variables from one or more wellheads and transmits the signals 
throughout the designed network. 

DSR Data Set Ready modem communications signal. 
DTE Data Terminal Equipment. 
DTR Data Terminal Ready modem communications signal. 
Duty Cycle Proportion of time during a cycle that a device is activated. A short duty cycle 

conserves power for I/O channels, radios, and so on. 
DVM Digital voltmeter. 
DVS Dual-Variable Sensor. A device that provides static and differential pressure inputs to a 

ROC.  

E 
EDS Electronic Static Discharge. 
EEPROM Electrically Erasable Programmable Read-Only Memory, a form of permanent memory 

on a ROC. 
EFM Electronic Flow Metering or Measurement. 
EIA-232  
(RS-232) 

Serial Communications Protocol using three or more signal lines, intended for short 
distances. Concerning RS232D and RS232C, the letters C or D refer to the physical 
connector type. D specifies the RJ-11 connector where a C specifies a DB25 type 
connector. 

EIA-422 
(RS-422) 

Serial Communications Protocol using four signal lines. 

EIA-485 
(RS-485) 

Serial Communications Protocol requiring only two signal lines. Can allow up to 32 
devices to be connected together in a daisy-chained fashion. 

EMF Electro-Motive Force. 
EMI Electro-Magnetic Interference. 
ESD Electro-Static Discharge. 
EU Engineering Units. Units of measure, such as MCF/DAY. 

F 
FCC Federal Communications Commission. See http://www.fcc.gov.  
Firmware Internal software that is factory-loaded into a form of ROM. In a ROC, the firmware 

supplies the software used for gathering input data, converting raw input data values, 
storing values, and providing control signals. 

FlashPAC 
module 

ROM and RAM module for a ROC300-Series unit that contains the operating system, 
applications firmware, and communications protocol. 

Flash ROM A type of read-only memory that can be electrically re-programmed. It is a form of 
permanent memory (requires no backup power). Also called Flash memory. 

FloBoss A microprocess-based device that provides flow calculations, remote monitoring, and 
remote control. A FloBoss is a type of ROC.  

FM Factory Mutual. 
Force Write an ON/OFF, True/False, or 1/0 value to a coil. 
FOUNDATION™ 
Fieldbus 

An open architecture for information integration, managed by the Fieldbus Foundation 
(www.fieldbus.org).  

FPV Compressibility Factor. 
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F (continued) 
FSK Frequency Shift Keypad.  
FST Function Sequence Table, a type of user-written program in a high-level language 

designed by Emerson Process Management’s Flow Computer Division.  
Ft Foot or feet. 

 

G 
GFA Ground Fault Analysis. 
GHz Gigahertz, 109 cycles per second 
GND Electrical ground, such as used by the ROC’s power supply. 
GP Gauge Pressure. 

H 
H1 A Foundation Fieldbus protocol operating at 31.25 kbit/s that interconnects field 

devices (such as sensors or I/O devices).   
HART Highway Addressable Remote Transducer.  
Holding 
Register 

Analog output number value to be read. 

HSE Protocol High Speed Ethernet protocol; a communications protocol operating at 100 Mbit/s used 
to integrate high-speed controllers (or servers) connected via Ethernet.   

Hw Differential pressure. 
Hz Hertz.  

I, J 
IC Integrated Circuit. Also, Industry Canada (more recently known as Measurement 

Canada), an organization that grants custody transfer approvals on certain ROC units.  
ID Identification. 
IEC Industrial Electrical Code or International Electrotechnical Commission. See 

http://www.iec.ch.  
IEEE Institute of Electrical and Electronic Engineers. A professional organization that, in 

conjunction with the International Standards Organization (ISO), establishes and 
maintains the Open System Interconnection (OSI) reference model and an international 
standard for the organization of local area networks (LANs). Refer to 
http://www.ieee.org. 

IMV Integral Multiplier Value, used in AGA3 (orifice) calculations.  
Input Digital input, a bit to be read. 
Input Register Input numeric value to be read. 
Local Port Also LOI; the serial EIA-232 (RS-232) port on the ROC through which local 

communications are established, typically for configuration software running on a PC.  
I/O Input/Output. 
I/O Module Module that plugs into an I/O slot on a ROC to provide an I/O channel. 
IRQ Interrupt Request. Hardware address oriented. 
ISO International Standards Organization. See http://www.iso.ch. 
IV Integral Value. 
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K 
KB Kilobytes. 
kHz KiloHertz. 

L 
LCD Liquid Crystal Display.  
LDP Local Display Panel, a display-only device that plugs into ROC300-Series units (via a 

parallel interface cable) used to access information stored in the ROC. 
LED Light-Emitting Diode. 
  
Logical Number The point number the ROC and ROC Plus protocols use for I/O point types are based 

on a physical input or output with a terminal location; the point numbers for all other 
point types are “logical” and are simply numbered in sequence.  

LNK Ethernet has linked. 
 

LOI Local Operator Interface (or Local Port). Refers to the serial EAI-232 (RS-232) port on 
the ROC through which local communications are established, typically for 
configuration software running on a PC. 

LPM Lightning Protection Module; a device that provides lightning and power surge 
protection for ROCs. 

LRC Longitudinal Redundancy Checking error checking. 

M 
m Meter. 
mA Milliamp(s); one thousandth of an ampere. 
MAC Address Media Access Control Address; a hardware address that uniquely identifies each node 

of a network.  
Manual mode For a ROC, indicates that the I/O scanning has been disabled.  
MAU Medium Attachment Unit. 
MCU Master Controller Unit.  
Modbus A popular device communications protocol developed by Gould-Modicon. 
MPU Micro-Processor Unit.  
mm Millimeter. 
MMBTU Million British Thermal Units. 
msec Millisecond, or 0.001 second. 
MVS Multi-Variable Sensor. A device that provides differential pressure, static pressure, and 

temperature inputs to a ROC for orifice flow calculations.   
mV Millivolts, or 0.001 volt. 
mW Milliwatts, or 0.001 watt. 

N 
NAP Network Access Point; the point in the distributed RTU network at which ROCLINK 800  
NEC National Electrical Code. 
NEMA National Electrical Manufacturer’s Association. See http://www.nema.org. 
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N (continued) 
Node A basic structural component of the Distributed RTU Network. A node (usually a FB107 

chassis housing a focused-functionality CPU and a Network Radio module) provides a 
data collection point that wirelessly transmits data throughout the designed network.   

NRM Network Radio module; a module used in both the FloBoss 107 and ROC00-Series 
based devices to wirelessly transmit information throughout the distributed RTU 
network. 

 

O 
OH Off-Hook modem communications signal. 
Off-line Accomplished while the target device is not connected (by a communications link). For 

example, “off-line configuration” refers to configuring an electronic file that is later 
loaded into a ROC.  

Ohms Units of electrical resistance. 
On-line Accomplished while connected (by a communications link) to the target device. For 

example, “on-line configuration” refers to configuring a ROC800-Series unit while 
connected to it, so that you can view the current parameter values and immediately 
load new values. 

Opcode Type of message protocol the ROC uses to communicate with the configuration 
software, as well as host computers with ROC driver software. 

Operator 
Interface 

Also LOI or Local Port; the serial EIA-232 (RS-232) port on the ROC through which 
local communications are established, typically for configuration software running on a 
PC.   

Orifice meter A meter that records the flow rate of gas through a pipeline. The flow rate is calculated 
from the pressure differential created by the fluid passing through an orifice of a 
particular size and other parameters.  

P, Q 
Parameter A property of a point that typically can be configured or set. For example, the Point Tag 

ID is a parameter of an Analog Input point. Parameters are normally edited by using 
configuration software running on a PC. 

PC Personal Computer. 
Pf Flowing pressure. 
P/DP Pressure/Differential Pressure. 
PI Pulse Input. 
PID Proportional, Integral, and Derivative control feedback action. 
PIT Periodic Timer Interrupt. 
PLC Programmable Logic Controller.  
Point Software-oriented term for an I/O channel or some other function, such as a flow 

calculation. Points are defined by a collection of parameters. 
Point Number The physical location of an I/O point (module slot and channel) as installed in the ROC. 
Point Type Defines the database point to be a specific type of point available to the system. The 

point type determines the basic functions of a point. 
Preset Number value previously determined for a register. 
PRI Primary PID control loop. 
Protocol A set of standards that enables communication or file transfers between two 

computers. Protocol parameters include baud rate, parity, data bits, stop bit, and the 
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type of duplex.  
PSTN Public Switched Telephone Network. 
PT Process Temperature. 
PTT Push-to-Talk signal. 
Pulse Transient variation of a signal whose value is normally constant. 
Pulse Interface 
module 

A module that provides line pressure, auxiliary pressure, and pulse counts to a ROC. 

PV Process Variable or Process Value. 

R 
Rack A row of slots on a ROC into which I/O modules can be plugged. Racks are given a 

letter to physically identify the location of an I/O channel (such as “A” for the first rack). 
Built-in I/O channels are assigned a rack identifier of “A” while diagnostic I/O channels 
are considered to be in “E” rack.  

RAM Random Access Memory. RAM is used to store history, data, most user programs, and 
additional configuration data. 

RBX Report-by-exception. RBX always refers to Spontaneous RBX in which the ROC 
contacts the host to report an alarm condition. 

RR Results Register; stores the Signal Value Analog (SVA). 
RFI Radio Frequency Interference. 
RI Ring Indicator modem communications signal. 
ROC Remote Operations Controller microprocessor-based unit that provides remote 

monitoring and control. 
ROCLINK 800 Microsoft® Windows®-based software used to configure functionality in ROC units.   
ROM Read-only memory. Typically used to store firmware. Flash memory. 
Rotary Meter A positive displacement meter used to measure flow rate, also known as a Roots 

meter. 
RTC Real-Time Clock. 
RTD Resistance Temperature Detector. 
RTS Ready to Send modem communications signal. 
RTU Remote Terminal Unit. 
RTV  Room Temperature Vulcanizing, typically a sealant or caulk such as silicon rubber.  
RS-232  Serial Communications Protocol using three or more signal lines, intended for short 

distances. Also referred to as the EIA-232 standard.  
RS-422 Serial Communications Protocol using four signal lines. Also referred to as the EIA-422 

standard.  
RS-485 Serial Communications Protocol requiring only two signal lines. Can allow up to 32 

devices to be connected together in a daisy-chained fashion. Also referred to as the 
EIA-485 standard. 

RX or RXD Received Data communications signal. 

S 
SAMA Scientific Apparatus Maker’s Association.  
SCADA Supervisory control and data acquisition; referring to a computer system that monitors 

and controls oil and gas pipeline systems.  
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S (continued) 
Script An uncompiled text file (such as keystrokes for a macro) that a program interprets in 

order to perform certain functions. Typically, the end user can easily create or edit 
scripts to customize the software. 

Soft Points A type of ROC point with generic parameters that can be configured to hold data as 
desired by the user. 

SP Setpoint, or Static Pressure. 
SPI Slow Pulse Input. 
SPK Speaker.  
SRAM Static Random Access Memory. Stores data as long as power is applied; typically 

backed up by a lithium battery or supercapacitor. 
SRBX Spontaneous Report-By-Exception. SRBX always refers to Spontaneous RBX in which 

the ROC contacts the host to report an alarm condition.  
SVA Signal Value Analog. Stored in the Results Register, it is the analog value that is 

passed between functions in an FST.  
SVD Signal Value Discrete. Stored in the Compare Flag, it is the discrete value that is 

passed down the sequence of functions in an FST. 
System 
Variables 

Configured parameters that describe the ROC; set using ROCLINK software.  

T 
T/C Thermocouple Input. 
TCP/IP Transmission Control Protocol/Internet Protocol.  
TDI Time Duration Input. 
TDO Time Duration Output. 
Tf Flowing temperature. 
TLP Type (of point), Logical (or point) number, and Parameter number. 
TX or TXD Transmitted Data communications signal. 
Turbine meter A device used to measure flow rate and other parameters.  

U 
Upload Send data, a file, or a program from the ROC to a PC or other host.  
USB Universal Serial Bus, a serial bus standard used to connect devices.  

V-Z 
V Volts. 
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Appendix B – Optimizing Wireless Communications 

The success of your distributed network of RTUs depends on a number 
of factors, none more important than how you manage the ability of the 
RTUs to effectively communicate with each other. This appendix 
provides general principles on how to optimize wireless 
communications.   

Note: This information is focused on wireless communications. For 
specific information on installing the components of your 
Distributed RTU™ Network (DRN), refer to Chapter 2 of this 
manual. For information on configuring and commissioning the 
DRN components, refer to Chapter 3.   

In This Chapter 

B.1 Wireless Basics...................................................................................... B-1 
B.1.1 Line-of-Sight.............................................................................. B-1 
B.1.2 Antennas ................................................................................... B-2 
B.1.3 Antenna Installations ................................................................ B-4 
B.1.4 Frequency Hopping .................................................................. B-5 

 

 

B.1 Wireless Basics  
The radio installed in the Network Radio module (NRM) is particularly 
suited to the kind of terrain you might encounter when setting up your 
network nodes on remotely located wellpads. With a line-of-sight (LOS) 
range of 20 km (12.4 miles), a wide range of operating temperatures, a 
low power requirement, a high noise immunity, and use of spread 
spectrum transmission (rather than narrow band transmission), the GXM 
radio operates more consistently and reliably in a unfriendly 
environment. 

Note: For detailed specifications on the NRM, refer to the product data 
sheets FloBoss™ 107 Network Radio Module (Form 
FB107:NRM) or the ROC800-Series Network Radio Module 
(Form ROC800:NRM), both available on the Remote 
Automation Solutions website.  

B.1.1 Line-of-Sight  
Assessing line-of-sight is essential as you place your nodes. Be aware of 
objects (mountains, buildings, trees, or infrastructures such as high-
power lines) which could block or otherwise impede a clear signal. 
Consider as well the earth’s curvature, which begins to affect line-of-
sight between 5-7 miles.   
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Figure B-1. Line of Sight  

Figure B-1 shows a line-of sight between a network node (on the right) 
and a network access point (on the left). Visually there may be no 
blockage to the signal, but anything that obstructs up to 40% of the oval 
area (called a “Fresnel zone”) around that line of sight can obstruct the 
full radio signal.  
Pole-mounted antennas move the Fresnel zone up and out of potential 
obstructions and are an effective way to address line-of-sight concerns.  

 

Figure B-2. Resolving LOS Issues with Pole-mounted Antennas  

B.1.2 Antennas  
Antennas are designed to efficiently radiate and receive radiated 
electromagnetic waves. When you select an antenna, consider the 
following characteristics:  
 Antenna type and radiation patterns  
 Power gain  
 Directivity  
 Polarization  
Radio applications most commonly use omnidirectional and Yagi 
antennas. Additionally, since a node may need a directional antenna 
mounted to an enclosure, ensure that the directional antenna is pointed 
toward the omnidirectional antenna (typically located on the network 
access point).   

Antenna 
Types 

Radio antennas have two basic categories: omnidirectional or 
directional. Omnidirectional antennas have a 360 degree horizontal 
antenna pattern and a certain amount of vertical pattern. Directional 
antennas (primarily based on the designs from its inventors, Drs. Yagi 
and Uda) can include parabolic dishes and directed devices. 
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Directional antennas tend to have a narrower antenna pattern (beam-
width) and a higher gain or “push” to the signal. 

Cable 
Length 

Because the antenna is mounted to the exterior of an enclosure, to 
minimize line loss, keep the coaxial cable that connects the module to 
the external antenna as short as possible. Guidelines for the kind of 
coaxial cable based on distances:  
 Up to 15 meters (50 feet): LMR-400   
 Up to 30 meters (100 feet): LMR-600  
 Up to 45 meters (150 feet): LMR-900  
 Up to 76 meters (250 feet): LMR-1200   

Antenna 
Gain 

Most simply, this is the value the signal increases (or “gains”), 
expressed as dBi, by the addition of an antenna.  

Mounting Mount antennas outside of metal enclosures, and ensure that antennas 
have at least 3 m (10 ft) of vertical separation from any other antenna.  

Recommended 
Antennas 

Remote Automation Solutions recommends the following 2.4Ghz 
omnidirectional, directional, and small mobile antennas.  
High Performance Omnidirectional Antennas (from PCTEL) 
 4 dBi Gain, Model Number MHO24004NM  
 6 dBi Gain, Model Number MHO24006NM  
 8 dBi Gain, Model Number MHO24008NM   
Mast-mount Omnidirectional Antenna (from PCTEL) 
 5.5 dBi Gain, Model Number MM024005PT36RPC  
Professional Grade Yagi (from Wavelink)  
 4 dBi Gain, Model Number PRO2400-4   
Heavy-duty Flexible Small Whip Mobile Antenna (from PCTEL) 
 5 dBi Gain, Model Number PCTP2425  
Small Omnidirectional blade-style Antenna (from PCTEL)  
 2.14 dBi Gain, Model Number NPAMB24495804   

Transmitter 
 Power Out 

The Federal Communications Commission (FCC) has established 
rules (Section 15.247) for the amount of power a transmitter may 
emit. For the frequency bandwidth the radio on the NRM uses (2400-
2483 MHz), the maximum power allowed is +36 dBm (or 4 Watts) 
Equivalent Isotropically Radiated Power.  
You can calculate EIRP by taking the transmitter power (the FB107 
RTU supports a maximum of +27 dBm or 500 mW), subtracting the loss 
due to coaxial cable, and then adding that result to the antenna gain. For 
example, +27 minus 3db (loss due to 39 ft. of LMR-400 Times wire 
coaxial cable) added to 15 dBi gain for a Yagi directional antenna (+24-
3+15) = 39 dBm, which is 3 dBm more than the FCC allowable limit.  
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To resolve this, you can either add another 39 ft. of LMR-400 cable or 
reduce the transmitter power by 3dB from +27 dBm to +24dBm 
(250mW). Either of these solutions lowers the dBm to the maximum 
legal EIRP value of 36 dBm or 4 Watts.   

B.1.3 Antenna Installations  
Depending on your geographical conditions, pole-mounted antennas 
may be required. Most antennas are packaged as kits, containing 
weatherproofing materials, mounting brackets and hardware; you must 
determine the appropriate pole materials and pole height.  
Because of their 360-degree signal transmission and reception patterns, 
omnidirectional antennas are most usually connected to the network 
access point (NAP) of the Distributed RTU™ Network. For network 
nodes, use directional antennas aimed toward the omnidirectional 
antenna.   
Harsh weather conditions require that you use external-quality antenna 
cabling. To reduce signal loss, limit the antenna cable to 9 meters (30 
feet). Typically, each end of the external antenna cable has a male Type 
N connector.  

Enclosures and 
Lightning Arrestors 

The network access point and the nodes require protective 
weatherproof enclosures. The external antenna cabling connects into 
the housing through a lightning arrestor, which is wired to a 
grounding rod.  
The internal antenna cable is typically 15-30 cm (6-12 inches) in length 
with a male Type N connector at one end and a male Type TNC 
connector at the other. It attaches to the lightning arrestor and connects 
the external antenna cable to the Network Radio module. 
The lightning arrestor typically has two female Type N connectors and a 
connector for the grounding wire. A grounding wire connects the 
lightning arrestor to the grounding rod. See Figure B-3. 
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A Pole-mounted omnidirectional antenna (connected to network access point) 

provides 360 degrees of signal transmission and reception 
B Pole mounting brackets and  hardware provided with antenna 
C Plastic cable ties secure external antenna cable to mast 
D Mast-mounted directional antenna (connected to network node) provides a 

directed pattern of signal transmission and reception. Directional antenna must 
be aimed at omnidirectional antenna.   

E Protective housing for node or network access point with installed lightning 
arrestor connected to grounding rod.  

F Grounding rod for lightning arrestor.  

Figure B-3. Antenna Installation (Omnidirectional and Directional)  

Waterproofing Waterproof all cable connections. Water in a cable can cause high 
VSRW/antenna reflection powers.  

B.1.4 Frequency Hopping 
“Frequency hopping” means that the carrier signal moves quickly from 
one frequency to another. The signal can move as many as 170 times 
per second, based on the signal’s “packet size” (the size of the 
encapsulated information being transmitted) and the “dwell time” (how 
long you want the signal to remain on one frequency).  
Frequency hopping is particularly useful in situations of high electronic 
“noise” that might result from one or more competing local radio 
networks or infrastructure challenges (such as high power transmission 
lines). You can modify the hopping pattern the module’s radio uses to 
avoid noise and produce a clearer signal. Additionally, frequency 
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hopping is difficult to jam (either intentionally or accidentally) and 
ensures the privacy of the signal.   
You can change the hopping pattern by changing the channel that a 
network uses (see Section 2.2, Configuring Nodes).  

Note: All devices on a specific network must use the same channel.   
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Appendix C – Using OE Field Tools to Access the DRN  

Remote Automation Solutions’ OpenEnterprise™ Field Tools product 
provides a convenient software container, which houses the 
configuration and programming software tools for our products.   
This appendix describes how to access the DRN if you are using Field 
Tools. In this situation, the PC loaded with Field Tools is connected 
directly to the device defined as the Network Access Point.  

Note: The steps required to add an RTU to the DRN using Field Tools 
are slightly different from the steps required when you are 
directly connected to an RTU.   

C.1 Adding an RTU to the DRN  
1. Open Field Tools, right-click All, select Site, and then Add. 

 
The Add Site dialog displays.  

 
2. Complete the New Site field to name the site and click OK. Field 

Tools adds the site to the directory tree.  
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3. Right-click the new DRN site and select Add connection.  

 
The New Connection screen displays.  

 
4. Define the new connection by completing three fields:  
 Name the field device to which you want to connect 
 Change the Link timeout value to 2000 ms (this allows Field 

Tools to connect wirelessly to the selected RTU 
 Select the Device address and Device group for the selected 

RTU.  
 Click Save to save your edits and then click Connect. Field 

Tools begins connecting to the device.  
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Note: Connecting to the device (and any transmitters connected to 
the device) may take several minutes.   

As it establishes connections, Field Tools adds components to the 
directory.  

 
5. You can then click on a device to display a device overview:   

 
6. Once you have established a connection to the Network Access 

Point, you can repeat steps 1 through 4 to add devices available 
through the NAP. After you complete step 4, Field Tools displays a 
verification dialog to indicate that it is building the connection:   
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When the connection completes, Field Tools adds the device to the 
directory:  
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